
OWNER’S MANUAL
Thank you for purchasing this FUJIFILM product.

This manual explains how to use your FUJIFILM Printpix Digital Photo Printer CX-400.

Before using your printer, thoroughly read the “OWNER'S MANUAL”.

After reading, store the “OWNER’S MANUAL” in a safe place.
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SAFETY NOTES
Thank you for purchasing this FUJIFILM product. Before using your new product, thoroughly read the “Owner’s
Manual” and use the product correctly. After reading the “Owner’s Manual” store it in a safe place.

The warning types explained below indicate the severity of the injury or damage
that can result if a warning is ignored or the product is used incorrectly.

Indicates that the subject of this
warning may cause death or
serious injury.

Indicates that the subject of this
warning may cause personal
injury or material damage.

The icons shown below indicate the type of warning to be observed.

Triangular icons notify
the user that care is
required.

Circular icons with a
diagonal bar notify the
user that the action
indicated is prohibited.

Fil led circles with an
exclamation mark notify
the user that an action
must be performed.

WARNING

Do not use this product if the power cable is not
plugged incorrectly.
Do not damage or modify the power cord.
Do not bend, twist or pull the power cord excessively.
Do not place heavy objects on the power cord or lay the power
cord under objects with corners.
Do not place the power cord near heating appliances or expose
the power cord to heat.
A short-circuit or heat discharge can cause an electric shock or fire.

Do not place the printer in an unstable location.
If the printer looses its balance and tips over or falls, it could
cause injury.

Do not place metal objects or receptacles containing
liquids on or near the printer.
Do not let water or foreign objects enter the printer.
If water or foreign objects enters the printer, turn off the power
switch and unplug the power cable from the power outlet.
Continued use of the printer in these circumstances can result in
short-circuit and cause a fire or electric short.
� Contact your FUJIFILM dealer or authorized FUJIFILM service

facility.

If an abnormality occurs, turn off the power switch and
unplug it from the power outlet.
Continued use when smoke or abnormal odor emanates from
the printer can cause a fire or electric shock.
� Contact your FUJIFILM dealer or authorized FUJIFILM service

facility.

Do not get wet.

Unplug from the
power outlet.

CAUTION

Do not place the printer in location where oily smoke,
steam, moisture, or dust is prevalent.
This could cause a fire or electric shock.

Keep out of the reach of small children.
Small children may stick their hand into the printer (paper
compartment cover, trash box slot, etc.) and be injured.

Do not block the ventilation slits.
Any blockage of the ventilation slits during use could result in a
buildup of heat inside the printer, causing a fire or other
damaged.
� Never do the following:

� Push the printer into a place that is narrow and poorly
ventilated.

� Use the printer on a carpet or blanket.

Do not place heavy objects on the printer.
The object or the printer could loose its balance and tip over or
fall, causing injury.

Do not use voltages other than the specified power
supply voltage.
This can cause a fire or electric shock.

Never attempt to disassemble or modify the printer
(remove the casing, etc.).
Do not use the printer when it has been dropped or the
casing is damaged.
This can cause fire or electric shock.
� Contact your FUJIFILM dealer or authorized FUJIFILM service

facility.

Do not plug in or unplug the printer with wet hands.
This can cause electric shock.

Wet hands 
prohibited.

WARNING CAUTION

�Kinds of printing
The following printings can be enjoyed with this printer.
Check page 101 for the print size.

Full Print
Prints full print (one picture on one sheet of
printing paper). This is the most basic printing
method. The picture to be printed can be
specified, or all the pictures on the memory card
can be printed.

➔P. 15
Print with border can also be selected.
Printing of border and border less prints can be
enjoyed by selecting this setting at printing.

➔P. 39

Multiple Print ➔P. 22
Prints the desired number of frames (2UP, 4UP,
9UP, 16UP, 25UP) on one sheet of paper. The
positions of the pictures to be printed can be
specified in the multiple frame.

✽ The specifiable number of frames varies
depending on the print size.

Index Print ➔P. 27
Prints the pictures of 25 frames on one sheet of
paper. This is very convenient when checking
the pictures on the memory card.

ID Print ➔P. 30
Prints up to 24 frames of the picture of the
chosen size on one sheet of paper.

Finish Photo/
Manual Adjustment Print ➔P. 35
Photo finishing can be enjoyed by using such
functions as “ZOOM/MOVE” that magnifies the
picture, “ROTATION” that changes the vertical
and horizontal direction of the picture, and
“EFFECT” that produces a sepia or monochrome
picture.

DPOF Print ➔P. 34
Prints according to the DPOF information on the
memory card.
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Always grasp the plug itself when unplugging the
printer.
Pulling on the cord could damage the cord and cause a fire or
electric shock.

Unplug the printer when cleaning it or not used for an
extended period.
Unplug the printer for safety.

Request routine inspection and cleaning of the interior
of the printer.
Accumulated dust inside the printer can cause fire or other
trouble.
� Request your FUJIFILM dealer or authorized FUJIFILM

service facility to clean the interior of the printer about once
every three years.

Do not move the printer while it is still plugged in.
This could damage the cord and cause a fire or electric shock.

Do not stare for a long time at the light emitting from the
printer.
Looking for short periods should not cause any harm, but
staring at the light for lengthy periods could result in impaired
eyesight.

MISCELLANEOUS NOTE

Installation site

� Do not use or store the printer where the temperature and
humidity are high, where vibrations are present, where the
printer will be in direct sunlight, where it is dusty or sandy, or
where the printer may be exposed to rain.

� If the printer interferes with radio or television reception,
install it away from the radio or television set.

Transporting

� Store the original packing material. It is needed when
repacking and shipping the printer later.

� When moving the printer, always remove the memory card.

Data

� The memory contents cannot be compensated. If data
cannot be written or read due to hardware or software
trouble, FUJIFILM is not responsible for memory contents
compensation.

Use

� Do not cover the printer with a cloth or blanket while it is in
use. It may cause erroneous operation or a serious accident.

� Use the printer on a firm and flat surface.

� Do not move the printer while it is operating. It may cause
trouble.

� Do not subject the printer to shock or vibration while it is
operating. It may cause an error or destroy the data.

Safety

� If foreign matter or a liquid gets into the printer, immediately
stop use, unplug the power cord, and contact your FUJIFILM
dealer or nearest FUJIFILM service facility.

Copyright

� The use of prints other than those created or photographed
by you without the permission of the copyright holder is
prohibited by copyright law, except when the prints are for
personal use.

Cooling Fan Operation

� When the temperature inside the printer rises to a certain
level, a cooling fan automatically begins to operate.

Similarly, when the temperature inside the printer drops
below a certain level, the cooling fan automatically stops.

Thermal Head Wear

� The thermal head will wear out, which results in diminished
print quality. When this occurs, the thermal head must be
replaced. Contact your FUJIFILM dealer.

Condensation

� Note that the following can result in the formation of
condensation in the printer:
• Placing the printer in very humid or steamy locations

• Moving the printer from a cold outdoor location into a warm
room.

• Moving the printer suddenly from an air-conditioned room
into a very warm and humid environment.

� Using the printer when condensation has formed inside the
printer can cause faults or abnormal operation, such as
impaired image quality, uneven color distribution and paper
jams.

� To dispel any condensation inside the printer, plug the
printer power cord into a power outlet, turn on the power by
pressing the POWER button, and leave the printer for
approximately 2 hours. The inside of the printer will warm-up
and dry out.

� These specifications are subject to change without notice. FUJIFILM shall not be held liable for damages
resulting from errors in this Owner's Manual.

BEFORE OPENING THE PACKAGE OF CD-ROM PROVIDED BY
FUJI PHOTO FILM CO., LTD., (“FUJIFILM”) PLEASE READ THIS
END USER LICENSE AGREEMENT CAREFULLY. ONLY IF YOU
DO AGREE TO THIS AGREEMENT, YOU WILL BE ABLE TO USE
THE SOFTWARE RECORDED ON THE CD-ROM. BY OPENING
THE PACKAGE, YOU ACCEPT AND AGREE TO BE BOUND BY
THIS AGREEMENT.

IMPORTANT Be sure to read this page before using the Software.

NOTICE

This End User License Agreement (“Agreement”) is an agreement
between Fuji Photo Film Co., Ltd. and you, which sets forth the
terms and conditions of the license granted for you to use the
software provided by FUJIFILM.
The CD-ROM contains third party software. In case a separate
agreement is provided by a third party supplier for its software, the
provisions of such separate agreement shall apply to the use of
such third party software, prevailing over those of this Agreement.

1. Definitions.
(a) “Media” means the CD-ROM titled “Software for Printpix Digital

Photo Printer CX-400” which is provided to you together with this
Agreement.

(b) “Software” means the software which is recorded on Media.
(c) “Documentation” means the operation manuals of Software and

other related written materials which are provided to you together
with Media.

(d) “Product” means Media (including Software) and Documentation
collectively.

2. Use of Software.
FUJIFILM grants to you a nontransferable, nonexclusive license:
(a) to install one copy of Software onto one computer in binary

machine executable form;
(b) to use Software on the computer onto which Software is installed;

and
(c) to make one backup copy of Software.

3. Restrictions.
3.1  You shall not distribute, rent, lease or otherwise transfer all or

any part of Software, Media or Documentation to any third party
without FUJIFILM’s prior written consent. You also shall not
sublicense, assign or otherwise transfer all or any part of the
rights granted to you by FUJIFILM under this Agreement without
FUJIFILM’s prior written consent.

3.2  Except as expressly granted by FUJIFILM hereunder, you shall
not copy or reproduce all or any part of Software or
Documentation.

3.3  You shall not modify, adapt or translate Software or
Documentation. You also shall not alter or remove copyright and
other proprietary notices that appear on or in Software or
Documentation.

3.4  You shall not, or shall not have any third party, reverse-engineer,
decompile, or disassemble Software.

4. Ownership.
All copyrights and other proprietary rights to Software and
Documentation are owned and retained by FUJIFILM or the third
party suppliers as indicated on or in Software or Documentation.
Nothing contained herein shall be construed, expressly or implicitly,
as transferring or granting any right, license, or title to you other than
those explicitly granted under this Agreement.

5. Limited Warranty.
FUJIFILM warrants to you that Media is free from any defect in
material and workmanship under normal use for ninety (90) days
from the date of your receipt of Media. Should Media not meet the
foregoing warranty, FUJIFILM shall replace such defective Media
with other Media bearing no defect. FUJIFILM’s entire liability and
your sole and exclusive remedy with regard to any defect in Media
shall be expressly limited to such FUJIFILM’s replacement of Media
as provided herein.

End User License Agreement

6. DISCLAIMER OF WARRANTY.
EXCEPT AS PROVIDED IN SECTION 5 HEREIN, FUJIFILM
PROVIDES PRODUCT “AS IS” AND WITHOUT WARRANTIES OF
ANY KIND, EXPRESS OR IMPLIED. FUJIFILM SHALL MAKE NO
WARRANTY, EXPRESS, IMPLIED OR STATUTORY, AS TO ANY
OTHER MATTERS, INCLUDING, BUT NOT LIMITED TO NON-
INFRINGEMENT OF ANY COPYRIGHT, PATENT, TRADE
SECRET, OR ANY OTHER PROPRIETARY RIGHTS OF ANY
THIRD PARTY, MARCHANTABILITY, OR FITNESS FOR ANY
PARTICULAR PURPOSE.

7. LIMITATION OF LIABILITY.
IN NO EVENT SHALL FUJIFILM HAVE ANY LIABILITY FOR ANY
GENERAL, SPECIAL, DIRECT, INDIRECT, CONSEQUENTIAL,
INCIDENTAL, OR OTHER DAMAGES (INCLUDING DAMAGES
FOR LOSS OF PROFITS OR LOST SAVINGS) INCURRED FROM
THE USE OF OR INABILITY TO USE PRODUCT EVEN IF
FUJIFILM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

8. No export.
You acknowledge that neither Software nor any part thereof, will be
transferred, or exported to any country or used in any manner in
violation of any export control laws and regulations to which
Software is subject.

9. Termination.
In case you breach any of the terms and conditions hereof,
FUJIFILM may immediately terminate this Agreement without any
notice.

10.Term.
This Agreement is effective until the date when you cease to use
Software, unless earlier terminated in accordance with Section 9
hereof.

11.Obligation upon termination.
Upon termination or expiration of this Agreement, you shall, at your
own responsibility and expense, delete or destroy immediately all
Software (including its copies), Media and Documentation.

12.Governing Law.
This Agreement shall be governed by and construed in accordance
with laws of Japan.

Please note that this Guide is written on the assumption that you
already have a basic understanding of how to use your PC
(personal computer), Windows and Macintosh.
For basic information on using your PC, Windows and Macintosh,
refer to the respective manuals supplied with your PC.

• Microsoft and Windows are trademarks of the Microsoft
Corporation of the U.S. registered in the U.S. and other
countries. Windows is an abbreviated term referring to the
Microsoft Windows Operating System.

• Macintosh, iMac and Mac OS are registered trademarks of
Apple Computer, Inc.

• QuickTime and the QuickTime logo are trademarks used
under license. The QuickTime logo is registered in the U.S.
and other countries.

• Adobe Acrobat® Reader™, ActiveShare™ and PhotoDeluxe
are trademarks of Adobe Systems Incorporated of the U.S.

• SmartMedia™ is a trademark of Toshiba Corporation.
• All other company or product names are trademarks or

registered trademarks of the respective companies.

Do not attempt to play the CD-ROM enclosed
with this product on an audio CD player.
Doing so could damage your hearing or
could damage your speakers or headphones.
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The CX-400 is equipped with a LCD (liquid crystal) monitor. By merely operating the printer in accordance with the
directions displayed on the monitor screen, you can enjoy the following:

Printer Paper tray 1 Trash box 1

Paper holder 1 Paper case 1 Retaining ring 1

Cleaning paper 1

CD-ROM
1Software for Printpix Digital Photo

Printer CX-400

Cleaning paper core 1 Power cord 1

Owner’s Manual 1(this manual)

Feature/System Configuration CHECKING THE CONTENTS OF THE CARTON

TV monitor

Video cable✽

Personal Computer with USB 
as a standard feature

Digital CameraNotebook PC SmartMedia PC card PC card 
adapter

Windows®98/98 SE/Me/XP

Mac OS 8.6 to 9.2

OS USB
Card reader

USB
Printer

✽ Use a video cable less 
than 3.0 m long.

USB cable✽

✽ Use a USB cable less than 3.0 m long.

� System Configuration

�Easily print digital camera picture data!
Memory card picture data can be directly printed.
When full-size prints are printed, borderless printing is
possible.
When printing, various photo finishing can also be performed.

For more information, see page 10.

�Use as a printer by connecting to a PC!
Use the CX-400 as a printer by connecting it to a PC using a
USB cable.

For more information, see page 52.

�All your family can enjoy pictures by
connecting the CX-400 to a television set!
Picture data can be viewed on a big screen by connecting the
CX-400 to a television set.

The viewing area may be different from that displayed on the
LCD monitor depending on the television set.

�Connect the CX-400 to a PC and read the
memory card data!
The CX-400 can be connected to a PC using a USB cable and
the data of SmartMedia or PC card can be read.

For more information, see page 52.

If there are any missing or damaged parts, please contact your dealer.

After printing, always place the
paper into the paper case and
store it (→P. 17).

Use when cleaning the head (→P. 44).

Always install the trash box.

✽ The type of power cord and plug
depends on the country.
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Name and Operation of Each Part

� Paper compartment cover
Open when loading and
unloading the paper roll.
Make sure to use the
printer with this cover
closed.

� LCD (Liquid crystal monitor)
Displays the operation menus
and the pictures in the memory
card.

� [DISPLAY] button
Press to switch the Display of
picture between 1 frame display
and 9 frames display.

� [4” × 6” SIZE] button
Press to switch the print size
to [4” × 6” size].

� [3” × 4” SIZE] button
Press to switch the print
size to [3” × 4” size].

� [ID PRINT] button
Press to switch print to [ID
print].

� [CUSTOM] button
Press when specifying the print
mode and when making various
settings.

� [BACK] button
Press to return to the last
picture and to interrupt
operation. � [SET] button

Press to set the setting
contents and picture.

� [EDIT] button
Press to perform the photo
finish and print quality
functions.

� [PREVIEW] button
Press to check the print
contents.

� [PRINT] button
Press to perform printing.
When the picture, quantity
of prints, etc. are set and
printing is possible, the
lamp lights steadily. During
printing, the lamp blinks.

� [QUANTITY] button : [+] [-]
Use to set the print number (set
number).

� Direction buttons: abdc
Use to select the menu and picture
and to change the picture zoom rate.

� [OPEN] button
Press to open the paper
compartment cover.

� Card select lever
Switch this lever when loading
a SmartMedia or PC card into
the printer.

� [BUSY] lamp
Blinks or l ights when the
SmartMedia or PC card is
operating.

� [EJECT] button
Press to remove the SmartMedia
or PC card.
✽ Press this button unti l  the

SmartMedia or PC card is
completely ejected.

� PC card slot
A PC card inserts into this slot.
This slot can be used when the
card select lever is in the [PC
CARD] position.
✽ Insert the PC card until it

clicks.

� SmartMedia slot
A SmartMedia card inserts into
this slot.
This slot can be used when the
card select lever is in the
[SmartMedia] position.
✽ Insert the SmartMedia card

until it clicks.� [POWER] button
Press to turn the
printer power on and
off.

� Trash box
Receives the cuttings while
printing.

� [USB MODE] switch
Switch according to the
function when the printer is
connected to a PC.

� Paper tray
Holds the printed paper.

� USB terminal 
(PC connection)
Connects the USB cable
(commercial part) when
connecting the printer to a PC.

� Ventilation holes
Exhaust the printer heat.
Do not block these holes.

� Power input terminal
Connects the power cable.

� Picture output terminal
(video output)
Connects to a television set
using a video cable.

� Paper alignment position
Use to align the top edge of the
paper when loading the paper.

� Paper tray hook

� Paper holder slot
The paper holder fits here.

�Owner’s Manual symbols

: Precautions to be observed during operation.

: More suitable usage method and operation points.

“       ” : Represents the name of the menu or window displayed on the LCD monitor.

[       ] : Represents the name of a printer button.

✽ In this manual, “memory card” refers to both SmartMedia and PC card.

Note

T IP

� Screen saver : This function prevents burning of the LCD monitor screen. When the display does
not change within 20 minutes, the monitor enters the screen saver mode. When any
button is pressed, the monitor returns to the original window.
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Try to print!1

1 Install the printer.
Set the printer on a flat, wide surface.

2 Connect the power cord to the printer.
Connect one end of the accessory power cord to
the power input terminal on the back of the
printer.
Plug the other end of the power cord into a
power outlet.

3 Install the trash box and paper tray to the printer.

• Place the printer far enough from a wall so that the
ventilation holes are not blocked.

• When the paper is loaded, the paper compartment cover
opens upward. Therefore, provide a free space of far enough
above the printer.

Note

• Do not turn on the printer power yet.

Note

• Always install the trash box.
• Do not turn on the printer power yet.

Note

• Do not obstruct the paper outlet or grab the paper.

Note

PREPARING THE PRINTER FOR USE
Use the printer after checking the accessories (→P. 7).

Procuring the necessary materials
Before starting to print, always procure the following items:

Usable paper
Printpix Paper (Sold separately)

This printer uses roll type paper.

Printer Trash box Paper tray

Power cord

Paper holder Retaining ring

Paper 
(Sold separately)

Paper case

Memory card (Sold separately)
(SmartMedia™ (PC card))

� Photo Type (100 mm/4 in. wide): RK-SD40
This is normal photo type paper.

Installing the printer

• Be sure that the paper retaining ring is installed.
• After use, always place the paper into the paper case.
• After using the printer, always place the paper into the paper case and store it avoiding the following locations:

- Where it is dry, where the humidity is high, or where it is dusty.
- In a vehicle in the summer, near heating equipment, and other places where the temperature is high.
- Near a window or other places where the paper will be exposed to direct sunlight or strong light.

• Paper with the protective bag unsealed cannot be stored for a long time. Use it as quickly as possible.
• Do not use paper whose effective date is expired.
• When the paper curls immediately after printing, it will flatten naturally if left alone.
• Do not drop the paper and damage the corners. It will cause the paper to jam.

Note

� Paper
When the printer detects the
paper end holes, it judges
that there is no more paper
and does not print any
farther. Do not cut off and use
this part. It will cause paper
jamming and printer trouble.

Language
The language displayed on the LCD monitor can be switched among “ENGLISH”, “FRENCH” and
“GERMAN”. The language display setting is saved even when the printer power is turned off. (→P. 40)

1 Press the [CUSTOM] button at the top of the
printer.
After using c to select “OTHERS”, use ab to
select “LANGUAGE” and press the [SET] button.

2 Use ab to select the desired language.

ENGLISH: English language display

FRENCH: French language display

GERMAN: German language display

3 When the [SET] button is pressed at the end of
setting, the monitor returns to the “OTHERS”
window.

T IP
• Initial setting is “ENGLISH”.
• The language display setting

is saved even when the
printer power is turned off.

Use c to select

Paper end hole

✽ The type of power cord and
plug depends on the country.

Select
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TURN ON THE POWER AND LOAD THE MEMORY CARD
Insert the memory card after turning on the printer power. The CX-400 can print the data of
SmartMedia and PC card. Insert the memory card to be used.

Turning on the printer power

LOAD THE PRINTING PAPER
Place the roll type paper onto the paper holder before loading the paper into the printer.
The printer automatically recognizes the type of paper.

Loading the paper

1 Open the paper compartment cover.
Press the [OPEN] button at the upper right-hand
side of the printer.

2 Separate the paper holder to two parts, white
and black.

3 Remove the printing paper from the moisture-
proof bag and insert the paper holders.

q Insert the white paper holder into the white end of
the paper core.

w Insert the black paper holder into the black end of
the paper core.

• Do not turn on the printer power yet.

Note

• Do not turn on the printer power yet.

Note

• Do not peel the paper holding sticker from the paper yet.

Note

• Do not peel the paper holding sticker from the paper yet.

Note

4

5 Peel the paper holding sticker from the paper
and adjust the paper position.
Turn the paper in the arrow direction, and align
the top edge of the paper to the paper alignment
position.

After loading the paper, close the paper
compartment cover.

Grasp the paper holder knob and place the
paper holder into the printer.
Insert the paper holder into the printer from the
top and pull it gently to the front.

1 Press the [POWER] button at the bottom front
left-hand corner of the printer.
The printer power comes on and a window
appears on the LCD monitor screen.

Loading SmartMediaTM

1 Select [SmartMedia] by sliding the card select
lever at the front center of the printer to the right.

2

• Do not touch the power supply section (gold-colored area) of
the SmartMedia card.

Note

• SmartMedia and PC card cannot be loaded into the printer at
the same time

Note

Insert the SmartMedia into the SmartMedia slot
with the power supply section (gold-colored area)
upwards and push it in until it clicks.

Capacity: 2 MB, 4 MB, 8 MB, 16 MB, 32 MB, 
64 MB, 128 MB

Voltage: 3.3 V
• The printer will not allow 5 V SmartMedia cards to be inserted

into the SmartMedia slot. Use a PC card adapter.
• Use a digital camera to format the SmartMedia.

Usable SmartMedia

White

White

Paper holding sticker

Black

Black

q w

T IP
• When the [BUSY]  lamp is

off, the memory card can be
removed at any time.

• Do not disconnect the power cord or remove the memory
card during printing.

Note
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SELECTING THE PHOTOGRAPHS
AND PRINTING

Select the picture to be printedLoading a PC card

1 Select [PC card] by sliding the card select lever
at the front center of the printer to the left.

2

• When using a PC card adapter, install the memory card to
the adapter in advance.

Note

• SmartMedia and PC card cannot be loaded into the printer at
the same time.

Note

Insert the PC card fully into the slot with the front
of the card facing upward.

Always use a PC card corresponding to PCMCIA TYPE I/II Standard compliant
ATA.
The following cards are automatically recognized.
Various memory cards can be used by using a PC card adapter matched to the
memory card.

Usable PC cards

• Microdrive only PC card adapter (IBM, MELCO, FUJIFILM)
• PC card adapter MSAC PC2 for memory stick (SONY)
• PC card adapter for CompactFlash (SUNTEX)
• PC card adapter for SD card (MATSUSHITA ELECTRIC)
• PC card adapter PC-AD3 for SmartMedia (FUJIFILM)
✽ Use a PC to format SmartMedia.
• Windows 98/98 SE/Me: Normal format
• Windows XP: FAT
• Macintosh: DOS format

1 When a memory card is loaded, the “SELECT
FRAME” window is displayed. Use ab to select
“EACH FRAME”, and press the [SET] button.

EACH FRAME:
The pictures on the memory card are displayed on
the monitor screen one frame at a time. Each frame
can be selected.

ALL FRAMES:
The pictures on the memory card are displayed on
the monitor screen in batches of 9 frames each. All
the frames can be selected (→P. 20).

2 The picture window is displayed. Use dc to
select the picture you want to print.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

T IP
• When the image is 4 frames or

more, and dc is pressed for
1 second or longer, the image
is quick scrolled. However, for
files other than Exif (JPEG,
TIFF-YC/RGB), only image
type characters are displayed.

T IP
• When the [BACK] button is

pressed before printing is
executed, the monitor is
returned to the picture
window.

T IP
• When the LCD monitor is

difficult to view, adjust the
brightness by pressing the
[DISPLAY] button for 2
seconds.

T IP
• When there is DPOF data,

pictures are printed in
accordance with the DPOF
data (→P. 34).

T IP
• You can specify any quantity

of pictures to be printed. If
you want to print more
pictures, select consecutive
pictures and set print quantity.

T IP
• When dc is pressed when

plural pictures were selected,
only the picture being printed
is displayed.

• To halt printing during multi-
picture printing, press the
[BACK] button.

Setting the print quantity

1 Use the [QUANTITY] [+] [-] buttons to set the
print quantity.
After setting the print quantity, press the [SET]
button.

Printing
Note: Do not pull out the trash box while printing.

1 Press the [PREVIEW] button and check the
pictures to be printed and the quantity of prints.
If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

� The following files cannot be printed in the full print, multi print and ID print modes:

Voice file
Cannot be printed.

Destroyed file
Files of supportable format, but since the picture
was destroyed, they cannot be displayed.
Supportable formats : Page 98 (Specifications)

Unknown file
File other than supportable format.
Cannot be displayed.
Supportable formats : Page 98 (Specifications)

Picture file with voice memory
Can be printed.

Picture file (AVI)
Cannot be printed.

PRINT ALL PICTURES (→P. 20):
The number of prints is counted for files that cannot be printed, but the files are not printed.

INDEX PRINT (→P. 27):
Icons are printed depending on the kind of picture. See page 27.

Select

When the “STARTUP MODE” setting is “FULL”
(→P. 40), the monitor can be returned to this
window by pressing the [BACK] button for 3
seconds or longer.

T IP
• When the [BUSY]  lamp is

off, the memory card can be
removed at any time.
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AT THE END OF PRINTING
Removing and storing the printing paper.

Removing the memory card

1 Press the [EJECT] button and remove the
memory card.

• Do not remove the memory card while the [BUSY] lamp is lit
or blinking.

• Do not touch the power supply section (gold colored area) of
the SmartMedia card.

• When using a PC card adapter, always remove it by pressing
the [EJECT] button. (Do not remove only the memory card in
the PC card adapter.)

Note

• Always use the retaining ring to prevent the paper from
becoming loose. If the retaining ring is not used, the paper
will come loose and cause jamming the next time the printer
is used.

• Do not remove the paper holder yet.

Note

Turning off the printer power

1 Press the [POWER] button at the front bottom
left-hand corner of the printer.
The LCD monitor and the printer power are
turned off.

Removing and storing the paper
Remove the paper from the printer and store it in the paper case.
When the paper is not in use, always store it in the paper case.

1 Press the [OPEN] button at the top right-hand
side of the printer.
Open the paper compartment cover.

2 Installing the retaining ring to the paper.
Install the retaining ring by pressing it firmly onto
the paper so that it will not become detached.

3 Grasp the paper holder knobs with both hands
and remove the holder from the printer.
Remove the paper holder after gently pushing it
to the back.

4 Remove the printing paper from the paper
holders.

q Remove the black paper holder.
w Remove the white paper holder.

5 Store the paper in the paper case.
Completely close the cover of the paper case
until it clicks and store it in a cool, dark place.

After removing the paper, close the printer paper
compartment cover.

• Be sure the retaining ring does not become detached from
the paper.

Note

• Be sure the retaining ring does not become detached from
the paper.

Note

• Be sure that the paper retaining ring is installed.
• After use, always place the paper into the paper case.
• After using the printer, always place the paper into the paper

case and store it while avoiding the following locations:
- Where it is dry, where the humidity is high, or where it is

dusty.
- In a vehicle in the summer, near heating equipment, and

other places where the temperature is high.
- Near a window or other places where the paper will be

exposed to direct sunlight or strong light.
• Paper with the protective bag sealed cannot be stored for a

long time. Use it as quickly as possible.
• Do not use paper whose effective date is expired.

Note

6 From the second printing, remove the retaining ring after loading the paper into the
printer.

Retaining ring

This completes the basic operation.
To enjoy various printing, refer to page 18 to 39.

White Black

w q

T IP
• Leave the paper holder in

the printer in preparation for
the next use.

T IP
• Empty the scraps in the trash

box in preparation for the
next use.

Retaining ring

✽ Close the cover of the
paper case completely.

click

• How to open
Open while pressing the
bottom of the case with
your finger.

• When the printer power is off and when the memory card is
removed, the quantity and edit settings are cleared.

Note
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DISPLAY OF PICTURE SWITCHING/PRINT SIZE SETTING
This section introduces the Display of picture switching function. Enjoy printing of various sizes using
this printer.

Enjoy various printing!2

Switching the display of picture
When the [DISPLAY] button is pressed, the
Display of picture is switched to 1 frame or 9
frames.

 19
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2 The set print mode window is displayed.
Use ab to select “SIZE”, and press the [SET]
button.

3 Use ab to select the preferred print size, and
press the [SET] button.

4 The display returns to the Set print window.
Select “FINISH SETTINGS” and press the [SET]
button. The Selection of picture window of each
mode is displayed.

• The items that are displayed vary depending on the print
mode and the type of paper loaded into the printer.

Note

• When the picture is to be photo finished, the message
“EDITING SPECIFIED FOR FRAME. CANCEL THE EDIT
SETTINGS?” is displayed.

Note

• The items that are displayed vary depending on the print
mode.

Note

• The items that are displayed vary dispending on the print
mode.

Note

Setting print size by printer button

1 The print size can be changed by pressing the
printer buttons.

Setting print size by window operation

1 Load the paper and memory card into the
printer, and press the [CUSTOM] button at the
top of the printer.
Use ab to select the preferred print mode, and
press the [SET] button.

Various print sizes can be set by window operation.

Type of 
Paper

Photo
Type

4” × 6” Size 100 mm × 148 mm/3.9 in. × 5.8 in. 
 74 mm × 100 mm/2.9 in. × 3.9 in. 
100 mm × 120 mm/3.9 in. × 4.7 in.
100 mm × 133 mm/3.9 in. × 5.2 in.
100 mm × 148 mm/3.9 in. × 5.8 in.
100 mm × 178 mm/3.9 in. × 7.0 in.

3” × 4” Size
CD Jacket Size

4” × 5.2” OR 6”

4” × 7” Size

Print Size
(Units mm/in.)

Button

4” × 6” SIZE 100 mm × 148 mm/4 in. × 6 in. 
74 mm × 100 mm/3 in. × 4 in. 3” × 4” SIZE

Photo Type
100 mm wide
(Units mm/in.)

1 frame displayed

No text displayed

9 frames displayed

Select

Select
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ALL FRAMES PRINT

Print setting

1 Load the paper and memory card into the
printer, and press the [CUSTOM] button at the
top of the printer.

2 Use ab to select “FULL”, and press the [SET]
button.

3 Use ab to select “FRAME”, and press the [SET]
button.

Setting print sets

6 The picture (9 frame) is displayed. Use abdc
to select the picture in the memory card.

7 Use the [QUANTITY] [+] [-] buttons to set the
print sets quantity.
After setting the sets quantity, press the [SET]
button.

8 Press the [PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

4

5 Use ab to select “FINISH SETTINGS”, and
press the [SET] button.

Use ab to select “ALL FRAMES”, and press the
[SET] button.

T IP
• To halt printing while printing

multiple prints, press the
[BACK] button.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

Select

Select

Select

Select

• The item that is displayed varies depending on the print mode.

Note

When the [BACK] button is pressed at the “after print quantity setting” window, the “SET
QUANTITY” window is displayed.
Use ab to the select the desired item, and press the [SET] button.

SET CURRENT FRAME TO 0: Sets the number of prints of the selected frame to 0.

SET ALL FRAMES TO 0: Sets the number of prints of all the frames to 0.

SELECT ALL FRAMES: Switches from the “EACH FRAME” mode to the “ALL FRAMES” mode.

SET EACH FRAME: Switches from the current “ALL FRAMES” mode to the “EACH FRAME” mode.

DESELECT THIS FRAME: Cancels the selected frame from the specification.

DESELECT ALL FRAMES: Cancels all the frames from the specification.

NO. OF SET: 1: Sets the quantity of print sets to be printed to 1.

DESELECT CHOSEN FRAME: Cancels the selected frames from the specification.

EXIT AND BACK TO MENU: Finishes frame selection and returns to menu.

BACK TO RANGE SETTING: Returns to frame selection zone determining.

� Cancelling the print quantity (set quantity)
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MULTIPLE PRINT
Multiple print prints the preferred number of frames (2UP, 4UP, 9UP, 16UP, 25UP) on one sheet of
paper. When the print size is [3” × 4” Size], only 2UP and 4UP multiple printing are possible.

Enjoy various printing!2
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Setting multiple print

1 Load the paper and memory card into the
printer, and press the [CUSTOM] button at the
top of the printer.
Use ab to select “MULTIPLE”, and press the
[SET] button.

2 Use ab to select “DIVISION”, and press the
[SET] button.

3 Use ab to select the preferred number of
frames, and press the [SET] button.

4

5 Use ab to select the preferred picture layout,
and press the [SET] button.

Use ab to select “PICTURE”, and press the
[SET] button.

• At this time, the number of frames cannot be selected for .

Note

Multiple print (same picture)

6 At the “SETTINGS FOR MULTIPLE” window,
use ab to select “FINISH SETTINGS”, and
press the [SET] button.
The picture is displayed.
Use dc to select the picture to be printed.

7 Use the [QUANTITY] [+] [-] buttons to set the
print quantity.
After setting the print quantity, press the [SET]
button.

8 Press the [PREVIEW] button, and check the
pictures to be printed and the quantity of prints.

9 If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

The following steps vary depending on the picture
arrangement type.
SAME: Prints the same picture at all frames (Page 23).

RANDOM (EACH FRAME):
Sequentially prints the pictures beginning from the top left (Page 24).

RANDOM (LAYOUT): Selects and prints the picture for each frame (Page 25).

RANDOM (ALL FRAMES): 
Sequentially prints all the pictures on the memory card beginning from the top left (Page 26).

eee
MULTIPLE PRINT (➔P. 22) continued

T IP
• To halt printing while printing

multiple prints, press the
[BACK] button.

T IP
• When the image is 4 frames

or more, and dc is pressed
for 1 second or longer, the
image is quick scrolled.
However, for files other than
Exif (JPEG, TIFF-YC/RGB),
only image type characters
are displayed.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

• “BORDER” cannot be set in the multiple print mode. Pictures
are printed with a border.

Note

The following steps vary depending on the picture
arrangement type. See the next page.

Select

Select

Select
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Enjoy various printing!2

Multiple print (random picture - each frame)

6 At the “SETTINGS FOR MULTIPLE” window,
use ab to select “FINISH SETTINGS”, and
press the [SET] button.
The picture is displayed.
Use dc to select the picture to be printed, and
press the [SET] button.

Repeat selecting frame multiple times as you like.

7

8

Use the [QUANTITY] [+] [-] buttons to set the
print sets quantity.
After setting the sets quantity, press the [SET]
button.

Press the [PREVIEW] button and check the
pictures to be printed and the quantity of print
sets.

9

Multiple print (random picture - layout)

6 At the “SETTINGS FOR MULTIPLE” window,
use ab to select “FINISH SETTINGS”, and
press the [SET] button.
The Select frame window is displayed.
Use abdc to arrange the pictures, and press
the [SET] button.

7 Use dc to select the picture to be printed, and
press the [SET] button.

The step window is displayed. Select the pictures

to be printed by repeating steps and .76

6

8 Use the [QUANTITY] [+] [-] buttons to set the
print quantity.
After setting the print quantity, press the [SET]
button.

9 Press the [PREVIEW] button and check the
pictures to be printed and the quantity of prints.

eee
MULTIPLE PRINT (➔P. 22) continued

eee
MULTIPLE PRINT (➔P. 22) continued

T IP
• When Preview is displayed,

frames can be fed using d
c for 1SET/2 PCS, or more.

• To halt printing while printing
multiple prints, press the
[BACK] button.

T IP
• Example of number of sets

The number of sets for 2UP
is shown below.
- When 4 pictures selected

=1 SET/2 PCS
- When 5 pictures selected

=1 SET/3 PCS

T IP
• To halt printing while printing

multiple prints, press the
[BACK] button.

T IP
• The picture of al l  frames

does not have to be selected.
Unselected frames are
displayed as a white space
on a colored background.
Therefore, you can enjoy
various forms of multiple
printing.

If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

10 If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. When printing is finished, the paper is ejected
from the printer and the Setting frame window is
displayed.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

T IP
• When the image is 4 frames

or more, and dc is pressed
for 1 second or longer, the
image is quick scrolled.
However, for files other than
Exif (JPEG, TIFF-YC/RGB),
only image type characters
are displayed.

T IP
• When the image is 4 frames

or more, and dc is pressed
for 1 second or longer, the
image is quick scrolled.
However, for files other than
Exif (JPEG, TIFF-YC/RGB),
only image type characters
are displayed.
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INDEX PRINT
Index print prints the pictures of 25 frames on one sheet of paper. It is very convenient in checking
the pictures on the memory card. Print size is [4” × 6” Size].

Enjoy various printing!2

Setting index print
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Enjoy various printing!2

Multiple print (random picture - all frames)

6 At the “SETTINGS FOR MULTIPLE” window,
use ab to select “FINISH SETTINGS”, and
press the [SET] button.
The picture is displayed.
Use abd c to check the pictures on the
memory card.

7 Use the [QUANTITY] [+] [-] buttons to set the
print sets quantity.
After setting the sets quantity, press the [SET]
button.

1 Load the paper and memory card into the
printer, and press the [CUSTOM] button.
Use ab to select “INDEX”, and press the [SET]
button.

2 Use ab to select “PICTURE”, and press the
[SET] button.

3 Use ab to select the printing zone, and press
the [SET] button.

The following steps vary depending on the
printing zone.
ALL FRAMES: Index prints all the frames on the memory card (Page 28).

SET RANGE:
Index prints by determining the zone of the frames to be printed (Page 29).

eee
MULTIPLE PRINT (➔P. 22) continued

8 Press the [PREVIEW] button, and check the
picture to be printed and the quantity of print
sets.

9 TIP
• To halt printing while printing

multiple prints, press the
[BACK] button.

� Index print icons

Voice file

Destroyed file
Files of supportable format, but since
the picture was destroyed, they cannot
be displayed.
Supportable formats: Page 98

(Specifications)

Unknown file
File other than supportable format.
Cannot be displayed.
Supportable formats: Page 98

(Specifications)

Picture file with
voice memory

Picture file (AVI)

If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

Select

Select
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Index print (all frames)

4 At the “SETTING FOR INDEX” window, use ab
to select “FINISH SETTING”, and press the
[SET] button.
The picture is displayed.
Use abd c to check the pictures on the
memory card.

5 Use the [QUANTITY] [+] [-] buttons to set the
print sets quantity.
After setting the sets quantity, press the [SET]
button.

Index print (set range)

4 At the “SETTING FOR INDEX” window, use ab
to select “FINISH SETTING”, and press the
[SET] button.
Use dc to select the picture at which index
printing is to start, and press the [SET] button.

5 Use dc to select the picture at which index
print is to end, and press the [SET] button.

6

7

8

eee
INDEX PRINT (➔P. 27) continued

eee
INDEX PRINT (➔P. 27) continued

6 Press the [PREVIEW] button, and check the
picture to be printed and the quantity of print
sets.

7 TIP
• To halt printing while printing

multiple prints, press the
[BACK] button.

Use the [QUANTITY] [+] [-] buttons to set the
print sets quantity.
After setting the sets quantity, press the [SET]
button.

Press the [PREVIEW] button, and check the
picture to be printed and the quantity of print
sets.

T IP
• To halt printing while printing

multiple prints, press the
[BACK] button.

If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

T IP
• When the image is 4 frames

or more, and dc is pressed
for 1 second or longer, the
image is quick scrolled.
However, for files other than
Exif (JPEG, TIFF-YC/RGB),
only image type characters
are displayed.

T IP
• When the image is 4 frames

or more, and dc is pressed
for 1 second or longer, the
image is quick scrolled.
However, for files other than
Exif (JPEG, TIFF-YC/RGB),
only image type characters
are displayed.
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ID PRINT
Prints up to 24 frames of the picture of the chosen size on one sheet of paper.

Enjoy various printing!2

Setting ID print

1 Load the paper and memory card into the
printer, and press the [ID PRINT] button at the
top of the printer.

2

3 Use dc to select the pictures you want to print.

4 Use the [QUANTITY] [+] [-] buttons to set the
print quantity.
After setting the print quantity, press the [SET]
button.

Use ab to “SIZE&LAYOUT” and press the
[SET] button.

Initial settings:
35 mm × 45 mm × 2
45 mm × 60 mm × 2

126 mm × 85 mm × 1
55 mm × 75 mm × 2
50 mm × 38 mm × 4
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6 If the preview contents are correct, press the
[PRINT] button.

The Printing window is displayed and printing is
started. At the end of printing, the paper ejects from
the printer and the monitor returns to the picture
window.

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

T IP
• To halt printing while printing

plural prints, press the
[BACK] button.

T IP
• The contents of “SIZE&

LAYOUT” can be changed
using “ID SETTINGS” (→P. 32).

T IP
• When the image is 4 frames

or more, and dc is pressed
for 1 second or longer, the
image is quick scrolled.
However, for files other than
Exif (JPEG, TIFF-YC/RGB),
only image type characters
are displayed.

5 Press the [PREVIEW] button and check the
pictures to be printed and the print quantity.

When the “STARTUP MODE” setting is “ID
PRINT” (→P. 40), the monitor can be returned
to this window by pressing the [BACK] button
for 3 seconds or longer. However, in this
case, the topmost row setting is automatically
selected for “SIZE&LAYOUT”.
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ID SETTINGS
ID print frame size and number of frames can be freely selected and registered.
The registered settings are saved even when the printer power is turned off.

Enjoy various printing!2

ID settings
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1 Load the paper and insert the memory card into
the printer, and press the [CUSTOM] button on
the printer.
Use ab to select “ID SETTINGS”, and press the
[SET] button.

2 Use ab to select the setting you want to
change, and press the [SET] button.

Select

Set number of frame

5 Set the number of frames.
Use ab to select the direction you want to set
and use dc to select the number of frames.

c : Increases the number of frames by 1.
d : Decreases the number of frames by 1.

At the end of setting, press the [SET] button.

Set frame size

4 Set the frame size.
Use ab to select the direction you want to set
and use dc to set the frame size.

c : Widens the frame size by 1 mm.
d : Narrows the frame size by 1 mm.

At the end of setting, press the [SET] button.

Set paper size

3 Use ab to select the paper size, and press the
[SET] button.

Setting check

6 If the preview contents are correct, press the
[SET] button.
The setting is registered and the monitor returns
to the “MODE” window.

T IP
• “ROTATION” can be set using
d c. When “ROTATION” is
set, the picture is automatically
turned during ID printing.

• When re-setting, press the
[BACK] button.

Try printing at the registered settings

1 Load the paper and insert the memory card into
the printer, and press the [CUSTOM] button on
the printer.
Use ab to select “ID PRINT”, and press the
[SET] button.

2 Use ab to select the newly registered ID photo
print setting, and press the [SET] button.
Thereafter, select the picture the same as from
step of page 30 and print.

“PAPER SIZE”, “FRAME SIZE”, “NUMBER OF
FRAMES” setting range

3

Select

• When the set frame size aspect ratio is not within the 0.5–2
range, an alarm display appears and the monitor returns to
the “FRAME SIZE” window. Input so that the aspect ratio is
within the 0.5–2 range.

Note

• 5 templates of frame layout can be registered.
• Any template can be replaced with your preference taking

the following procedure.

Note

• The image of the first frame of the memory card is used at
the preview window. When the first frame is destroyed, is
unknown, or is an audio file, an icon is displayed and preview
display is not performed. In this case, the “ROTATION”
setting remains the same as the last time.

Note

100 mm × 148 mm

74 mm × 100 mm

55 mm × 100 mm

20 mm − 142 mm

20 mm − 194 mm

20 mm − 194 mm

20 mm − 94 mm

20 mm − 68 mm

20 mm − 49 mm

Frame Size Number of Frames
Paper Size

VerticalHorizontal

1 − 6

1 − 4

1 − 4

1 − 4

1 − 3

1 − 2

VerticalHorizontal
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EDIT/PRINT QUALITY
Enjoy picture finishing using such functions as “ZOOM/MOVE” that magnifies the picture,
“ROTATION” that changes the direction (vertical, horizontal) of the picture, and “EFFECT” that
changes the picture to sepia, monochrome or etc.

Enjoy various printing!2

Setting the Edit/Print Quality menu

 34

DPOF PRINT
DPOF print prints according to the DPOF information on the memory card. DPOF print can be
performed by loading the paper and a memory card containing DPOF data.

Enjoy various printing!2

DPOF print

• DPOF printing works only when print size is set to 4” × 6”
size.

• The DPOF settings on the memory card cannot be changed
with this printer. The DPOF information on the memory card
cannot be checked either.

• “JOB” is print specification.

Note

1 When there is DPOF information on the memory
card, the “ DPOF CHECK” window is
displayed.

When performing DPOF print:
Press the [PRINT] button.

When there is the DPOF information not corresponding
to the printer, a message is displayed.

When not performing DPOF print:
When the [BACK] button is pressed, the printer
advances to normal printing operation. (Step 
on page 15.)

1

1 Select the picture to be finished in each mode,
and press the [EDIT] button.
The “EDIT/PRINT QUALITY” window is displayed.
Use ab to select the preferred picture finish,
and press the [SET] button.

ZOOM/MOVE:
Magnifies the picture and adjusts its position. This
function prints the picture so that the parts you do
not want to see are cropped (Page 35).

ROTATION:
This function sets the direction (vertical, horizontal)
of the picture in 90° steps (Page 36).

EFFECT:
This function lets you enjoy printing with a different
atmosphere, such as sepia and monochrome, than
the original picture (Page 36).

CANCEL EDIT:
This function formats “Zoom rate/Move position”,
“Effect” and other photo finishing (Page 37).

PRINT QUALITY:
This function allows adjustment of the brightness and
density of the color of all the pictures to be printed.
Adjusted print quality can also be formatted (Page 37).

• Editing cannot be performed in the Index mode.

• When “ROTATION” is performed after “ZOOM/MOVE”, the “ZOOM/MOVE”  settings
are canceled. When performing both “ZOOM/MOVE” and “ROTATION” photo
finishing, perform them in “ROTATION” → “ZOOM/MOVE” order.

Note

Zoom rate/Move position

1 The “ZOOM RATE” window is displayed.
Use ab to adjust the picture zoom rate.

a : Raises the picture zoom rate.

b : Lowers the picture zoom rate.

After adjusting the zoom rate, press the
[DISPLAY] button.

2

• Do not touch the moving paper while printing.
• Do not remove the memory card while printing.
• Do not pull out the trash box while printing.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

T IP

T IP

• For 1 frame display, “ZOOM/
MOVE” picture finishing can
be performed by using ab
at the “Selection of picture”
window.

• When you want to return the
picture to its state before
finishing, press the [BACK]
button.

• When you want to return the
picture to its state before
finishing, press the [BACK]
button.

The “MOVE POSITION” window is displayed.
Use abdc to adjust the part you want to print.
After adjustment, press the [SET] button.
A picture with is displayed.
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Rotation

1 The “ROTATION” window is displayed.
Use dc to adjust the picture angle.

d : Rotates the picture 90 degrees to the left
(counterclockwise).

c : Rotates the picture 90 degrees to the right
(clockwise).

After adjusting the angle, press the [SET] button.
A picture with is displayed.

Print quality

1 The “PRINT QUALITY” window is displayed.
Use ab to select the item you want to adjust
and use dc to adjust the value.

DENSITY: Adjusts the picture density.

CONTRAST: Adjusts the picture contrast.

SHARPNESS: Adjusts the picture sharpness.

COLOR CONTROL:
Adjusts the picture color. There are three color
controls. Cyan, magenta and yellow are adjusted.

CYAN - ↔ +
MAGENTA - ↔ +
YELLOW - ↔ +

COLOR: Adjusts the density of the picture color.

INITIAL:
Returns the adjustment value of all the images to be
printed to the center.

2 After setting, press the [SET] button.
The monitor returns to the original display of
picture window.

Effect

1 The “EFFECT” window is displayed.
Use ab to select the preferred effect, and press
the [SET] button.

2 The Effect result window is displayed.
After checking the result, press the [SET] button.
A picture with is displayed.

When the “EFFECT” is used, printing of a different atmosphere than the original picture can be enjoyed.
The following photo finishing is possible using the “EFFECT”.
• FANTASY (Brightening effect) • SEPIA TONE     • MONOCHROME     • PAINTING TONE

This function displays all the pictures on the memory card on the monitor screen and controls the
picture quality of all the pictures to be printed.

Cancel edit

1 Execute format processing at the “EDIT/PRINT
QUALITY” window.
Use ab to select “CANCEL EDIT”, and press
the [SET] button.
A picture without is displayed.

This function returns the selected picture to its state before editing.

T IP
• When you want to return the

picture to its state before
finishing, press the [BACK]
button.

T IP
• When you want to return the

picture to its state before
manual adjustment, press
the [BACK] button.

T IP
• The control picture quality

contents are saved even
when the printer power is
turned off and are effective
the next time the power is
turned on.

T IP
• When you want to return the

picture to its state before
finishing, press the [BACK]
button.

Select
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OTHER PRINT SETTINGS
Pictures can be printed by setting [Print size], [Set border], and other items, as preferred.

Enjoy various printing!2

Print settings

1 Load the paper and memory card into the printer
and press the [CUSTOM] button at the top of the
printer.
Use ab to select the preferred print mode, and
press the [SET] button.

2 The setting window of each print mode is
displayed.
Use  ab to select the item you want to set and
press the [SET] button.

SIZE:
Sets the paper finish size (Page 18).

DATA:
Sets if “DATE” and “FILE NAME” are to printed
simultaneously (Page 39).

BORDER:
Sets if “Without border” printing is to be performed
(Page 39).

FRAME:
Sets if “Each frame” or “All frames” is specified as
the print quantity (Page 20).

DIVISION:
Sets “Number of frames” of the picture per one
sheet of paper (Page 22).

PICTURE: (in the screen of SETTINGS FOR MULTIPLE) 
Sets how the pictures are to be arranged at the
divided frames (Page 22).

PICTURE: (in the screen of SETTINGS FOR INDEX) 
Sets the zone of the frames to be printed (Page 27).

• The items that are displayed vary depending on the print
mode.

Note

• This setting can be used only in the [FULL] and [MULTIPLE]
print modes.

• The date is not printed on pictures without date data.
• Only English numerals and English letters can be printed.
• The order of year, month and day depends on the country.

Note

Set data print

1 Use ab to select the desired setting.

DATE:
The photographed date is printed at the bottom
right-hand corner of the picture when printing.
(Example: 08. 01. 2002)

FILE NAME:
The filename of the picture is printed at the bottom
right-hand of the picture when printing.
(Example: 100-0001)

NOTHING:
Characters are not printed when printing.

2 At the end of setting, press the [SET] button.

Return to step on page 38.2

2 At the end of setting, press the [SET] button.

Return to step on page 38.2

• This setting can be used only in the [FULL] print mode.

Note

Set border

1 Use ab to select the desired setting.

WITH:
A border is printed around the picture when
printing.

WITHOUT:
A border is not printed around the picture when
printing.

T IP
• Initial setting is “WITHOUT”.

3 At the end of print setting, use ab to select
“FINISH SETTINGS” and press the [SET] button.

Return to step on page 38.1

• The set contents are saved until re-set or the power is turned
off. However, the data print setting is saved even when the
power is turned off.

Note

Select

Following English numerals and letters can be printed.

A B C D E F G H I J K L M NA B C D E F G H I J
0 1 2 3 4 5 6 7 8 9

K L M N
O P Q R S T U V W X Y Z
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Other methods of use3

OTHERS SETTINGS
STARTUP MODE, LANGUAGE, VARIOUS SETTINGS and etc. can be set. 
Refer page 10 regarding how to set LANGUAGE.
Various settings such as “AUTO QUALITY ADJUSTMENT” and “SLIDE SHOW” can be made. Make these settings
before printing.

Startup mode

1 Press the [CUSTOM] button at the top of the
printer.
Use c to select the “OTHERS” tab.

2 Use ab to select “STARTUP MODE”, and press
the [SET] button.

3 The “VARIOUS SETTINGS” window is displayed.
Use ab to select the item and press the [SET]
button.

AUTO QUALITY ADJUSTMENT:
Automatically performs optimum compensation
according to the photographed scene of each
picture when printing (Page 41).

IMAGE DISPLAY ORDER:
Sets the order in which the picture data is displayed
when a memory card was loaded into the printer
(Page 42).

SLIDE SHOW:
Setting for “Slide Show” that automatically
reproduces the picture data on the memory card
(Page 42).

LCD MONITOR BRIGHTNESS:
Adjusts the brightness of the LCD monitor (Page 43).

INITIALIZE SETTINGS:
Returns the various setting to the factory shipping
state (Page 43).

4 After the monitor returns to the “VARIOUS
SETTINGS” window of step , use ab to
select “FINISH SETTINGS” and press the [SET]
button. The monitor returns to the window of
Step .1

3

Auto quality adjustment

1 Use ab to select the desired setting.

YES: Picture quality is automatically adjusted.

NO: Picture quality is not automatically adjusted.

Automatically performs optimum compensation according to the photographed scene of each picture
while printing.
For instance, with backlighted scenes, the subject easily appears dark. This function automatically
compensates for this so that the subject is printed beautifully.

2 At the end of setting, press the [SET] button.

The “VARIOUS SETTINGS” window is displayed.

T IP
• Initial setting is “YES”.

Select

3 The “STARTUP MODE” window is displayed.
Return to the “OTHERS” window by using ab to
select and pressing the [SET] button.

FULL:
At power startup and when the [BACK] button was
pressed for 3 seconds or longer, the printer enters
the FULL 4” × 6” print mode.

ID PRINT:
At power startup and when the [BACK] button was
pressed for 3 seconds or longer, the printer enters
the ID PRINT (topmost row “SIZE&LAYOUT”) mode.

Use c to select

Various settings

1 Press the [CUSTOM] button at the top of the
printer.
Use c to select the “OTHERS” tab.

2 Use ab to select “VARIOUS SETTINGS”, and
press the [SET] button.

Select

Use c to select

Select

T IP
• The contents of the various

settings are saved even
when the printer power is
turned off and are effective
the next time the power is
turned on.

• The startup window selection settings are saved even when
the printer power is turned off.

Note

T IP
• Initial setting is “FULL”.
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Other methods of use3

Setting slide show

1 Set the interval the pictures are to be displayed.
Use d to select the “SPEED” tab. Use ab to
select the desired setting.

SLOW: 
The time the picture is displayed becomes long.

FAST: 
The time the picture is displayed becomes short.

2 Set if repeat reproduction is to be performed.
Use c to select the “LOOP” tab. Use ab to
select the desired setting.

YES: 
The pictures on the memory card are reproduced
repeatedly.

NO: 
The pictures on the memory card are not
reproduced repeatedly.

Setting for “SLIDE SHOW” that automatically reproduces the picture data on the memory card.

Initialize settings

1 Select “INITIALIZE” and press [SET] button.

The various printer settings return to their factory
shipping state.

The “VARIOUS SETTINGS” window is displayed.

This function returns the various setting to the factory shipping state.

� Executing slide show

q Load the memory card into the printer, and press the
[CUSTOM] button at the top of the printer. 
Use c to select “OTHERS”, then use ab to select
“SLIDE SHOW” and press the [SET] button.

w The picture data on the memory card is automatically
reproduced.
When the [BACK] button is pressed, the slide show is
stopped.

• Do not remove the memory card during reproduction.
• When an error window or information window is displayed,

refer to pages 46 to 50.

Note

3 At the end of setting, press the [SET] button.

The “VARIOUS SETTINGS” window is displayed.

T IP
• Initial setting is “SLOW”.

T IP
• Initial setting is “YES”. Select

Use c to select

T IP
• When the [DISPLAY] button

is pressed, only pictures are
displayed.

Image display order

1 Use ab to select the desired setting.

FROM THE TOP:
Displays the first picture data when a memory card
was loaded into the printer.

FROM THE END:
Displays the last picture data when a memory card
was loaded into the printer.

Sets the order in which the picture data is displayed when a memory card was loaded into the printer.

2 At the end of setting, press the [SET] button.

The “VARIOUS SETTINGS” window is displayed.

T IP
• Initial setting is “FROM THE

TOP”.

LCD monitor brightness adjustment 

1 Use dc to adjust the brightness of the LCD
monitor, and press the [SET] button. 

The “VARIOUS SETTINGS” window is displayed.

Adjusts the brightness of the LCD monitor.

T IP
• The “LCD MONITOR BRIGHTNESS

ADJUSTMENT” window can also
be displayed by pressing the
[DISPLAY] button for 2 seconds
at the Display of picture window.
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When trouble occurs4

HEAD CLEANING
To print cleanly all the time, the printer must be serviced. When the print quality deteriorates or there
are white lines running down the length of the paper, perform head cleaning.

Executing head cleaning

1 Press the [CUSTOM] button on the top of the
printer.
Use c to select the “OTHERS” tab, and then
use ab to select “HEAD CLEANING” and press
the [SET] button.

2 Set the cleaning paper core at the paper holder
and set the paper holder from the top of the
printer.

3 Set the cleaning paper at the printer.
Hold the cleaning paper with the white side at
the front and set it straight into the paper holder.
Insert the cleaning paper between the cleaning
paper core and printer body and push it in
approximately 1 cm using both hands.

4 After pressing the cleaning paper with your hand
so that the sheet enters the printer, close the
paper compartment  cover.
After that, execute head cleaning by pressing
the [SET] button.
The “Executing head cleaning” window is
displayed.

5 At the end of head cleaning, the “HEAD
CLEANING COMPLETED” window is displayed.
Remove the cleaning paper and cleaning paper
core from the printer.
The monitor returns to the “OTHERS” window.

T IP
• To continue printing, load the

printing paper into the
printer.

PRINTER BODY

Select

Use c to select

Top view

Cleaning paper

When the image above is 
not displayed, re-set the 
cleaning paper.

• When printing is not clean even when head cleaning is
executed, contact your FUJIFILM dealer.

Note

Symptom Cause Remedy

Power is not supplied.

Is the power plug disconnected from the outlet? Plug the power plug firmly into the outlet.

Is the power cord disconnected from the
rear panel power socket? Plug the power cord firmly into the socket.

Picture does not appear
on the TV screen.

Cable to TV set is connected incorrectly. Connect the video cable correctly.

When a wide screen TV set
is used, the characters, etc.
overflow from the screen
and cannot be seen.

TV display mode is not [Normal].
Switch the TV display mode to [Normal].
Refer to the TV set owner's manual for the
operating instructions.

LCD monitor is difficult to
see. —

Execute [LCD monitor brightness adjustment] of
the various settings and adjust to an easy-to-
view brightness. When adjusting the brightness,
watch the LCD monitor from the front.

Memory card cannot be
inserted.

The direction in which the memory card is
inserted is incorrect.

Insert the memory card in the correct
direction.

Slot into which the memory card is being
inserted is incorrect. Insert the memory card into the correct slot.

Card select lever selection is incorrect. Switch the card select lever to the position of
the memory card to be used.

Paper cannot be loaded. —

Refer to Loading the paper on page 12 and
the sticker on the back of the paper
compartment cover and load the paper
correctly while paying attention to the
direction of the paper holder and paper.

Cannot print even by
pressing the [PRINT]
button.

Quantity of prints is not set. Set the quantity of prints.

Printer cuts and ejects the
paper.

• When the power is turned on, there is paper
remaining in the printer paper feed path.

• The trash box or the paper compartment
cover may have been opened while printing.

Do not open the trash box or paper
compartment cover while printing. Also, do
not unplug the power cord while printing.

Printed picture is fuzzy or
there are vertical scratches
running down the picture.

Head is dirty.
Use the accessory cleaning paper to clean
the head (→P. 44).

The quantity of prints (sets)
does not increase even
when the [QUANTITY]
button is pressed.

Total quantity of prints is set to 1000 or
more or 100 or more for each frame.

Set the total quantity of prints up to 1000 and
up to 100 for each frame.

Print picture is grainy. Picture was magnified and printed
because the picture size was too small.

It is recommended that printing be performed
at a picture size of 640 × 480 pixels or more.

—

Plug the power cord into the power outlet and turn
on the power by pressing the [POWER] button.
After paper is ejected after the mechanism of the
printer is formatted, turn off the power.

Error state. Check the message on the LCD monitor and
refer to page 46 and subsequent pages.

TV input is not [Video]. Switch TV input to [Video].

Power is turned on, but
the printer does not
operate.

A safety device may have operated.
Unplug the power cord from the power outlet,
wait a while, and then plug the power cord
back in and turn on the power.

Power cord was unplugged
while printing.
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When trouble occurs4

Symptom Cause Remedy

Trash box is full.

• Empty and reinstall the trash box.
• Unplug the power cord from the power

outlet, wait a while, and then plug the
power cord back into the power outlet and
turn on the power.

• If the printer still remains in this state,
contact your FUJIFILM dealer.

Printer ran out of paper while printing. Load the paper correctly.

An error was generated because the trash
box was pulled out while printing.

Reinstall the trash box, wait a while, and then
advance to the next picture.

Paper roll may be loose.

• Reset the paper so there is no gap
between the paper holder and the paper.

• Open the paper compartment cover and
tighten the paper on the roll and reload the
paper.

• If the printer still remains in this state,
contact your FUJIFILM dealer.

Symptom Cause Remedy

• Paper is not loaded.
• Edge of paper is not aligned. Load the paper correctly.

• Special paper is not used.
• There is a gap between the paper

holder and the paper.

• Load the Printpix Paper.
• Reload the paper so that there is no gap

between the paper holder and the paper.

• Paper is not loaded.
• Edge of paper is not aligned.
• The paper holding sticker is not peeled

off.

• Load the paper correctly.
• Peel off the paper holding sticker.

• Special paper is not used.
• There is a gap between the paper

holder and the paper.

• Load the Printpix Paper.
• Reload the paper so that there is no gap

between the paper holder and the paper.

Mechanism or circuits did not operate
correctly.

• Unplug the power cord from the power
outlet, wait a while, and then plug the
power cord back into the power outlet and
turn on the power.

• If the printer still remains in this state,
contact your FUJIFILM dealer.

Paper is jammed.
• Trash box is full.
• Paper was not loaded properly.
• Paper was not ejected properly.

• Empty and reinstall the trash box.
• Unplug the power cord from the power

outlet, wait a while, and then plug the
power cord back into the power outlet and
turn on the power.

• Open the paper compartment cover and
wind the paper by turning the holder toward
rear with both hands.

• If the printer still remains in this state,
contact your FUJIFILM dealer.

• Memory card is faulty.
• Memory card is not inserted fully.

• Remove the memory card and reinsert it
until it clicks.

• Do not touch the [EJECT] button while the
[BUSY] lamp is lit or blinking.

The picture data to be processed is not on
the memory card.

There are no displayable pictures. Check the
contents of the memory card.

The [EJECT] button may have been
touched while the [BUSY] lamp was
blinking.

• Do not touch the [EJECT] button while the
[BUSY] lamp is lit or blinking.

• Use the [SET] button to start operation.

Cleaning paper was not put in correctly. Open the paper compartment cover and put
in the cleaning paper correctly.

WHEN AN ERROR IS DISPLAYED ON THE LCD MONITOR
See when a window with is displayed.
When the printer power is off and when the memory card is removed, the quantity and edit settings are cleared.

— Load Printpix paper and close the paper
compartment cover.
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When trouble occurs4

Symptom Cause Remedy

Paper was cut because printing was
interrupted.

Wait a while and operation will advance to
the next window.

Printer is warming up or overheated. Wait a while.

Memory card is not inserted. Insert a memory card.

Paper trash box is not installed. Install the trash box.

— Put in the Cleaning paper and Cleaning
paper core.

Symptom Cause Remedy

An attempt was made to select a print
size that cannot be selected with this
number of divisions.

Change the number of divisions and select
change print size or cancel print size change
and press the [SET] button.

An attempt was made to select a number
of divisions that cannot be selected with
this print size.

Change the print size and select change
number of divisions or cancel number of
divisions change and press the [SET] button.

There is a editing set frame. The problem
is whether or not finish setting remains
when printing after the end of printing.
Clear the quantity of prints setting.

When you want to start a new printing without
edit setting remaining, select “YES”. When
you want to continue printing with edit setting
remaining, select “NO”.

When picture turn is performed after zoom
setting, zoom setting is formatted.

When you want to turn the picture even
though zoom setting was formatted, select
“YES” and press the [SET] button. When you
do not want to format the zoom setting, select
“NO” and press the [SET] button.
When “ROTATION” is performed after
“ZOOM/MOVE”, the “ZOOM/MOVE”  settings
are canceled. When performing both
“ZOOM/MOVE” and “ROTATION” photo
finishing, perform them in “ROTATION” →
“ZOOM/MOVE” order.

Since an attempt was made to change the
print mode, the previously quantity and edit
settings are canceled.

To perform the print mode change, select
“YES” and press the [SET] button. To cancel
the print mode change, select “NO” and
press the [SET] button.

Paper compartment cover is open. Close the paper compartment cover.

WHEN DATA IS DISPLAYED ON THE LCD MONITOR
See when a window with or the “Select item” window was displayed.

Paper compartment cover is open. Close the paper compartment cover.
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Definition of terms

� DCF
Short for Design rule for Camera fi le system, standard
established by the Japan Electronics and Information Technology
Industry Association (JEITA).

� DPOF
Stands for Digital Print Order Format, a data format for recording
the frame to be printed, the number of prints, and other
information from among pictures taken with a digital camera to a
SmartMedia card.

� Exif 
Exif is a full color still picture format for digital still cameras
approved by the Japan Electronics and Information Technology
Industry Association. It is interchangeable with TIFF and JPEG
and can be handled by general picture processing software. It
also sets forth a thumbnail and camera information recording
method. DCF, which includes folder structure and file name rules,
is a JEITA Exif Print Standard.

� Exif Print
Exif Print is the general name of Exif 2.2 that amplifies the
recording method stipulation of the original standard Exif 2.1.
High quality print output that faithfully reflects the digital camera
photographic data and the intent of the photographer can be
obtained.

� Folder
A location in which related files are stored. Other folders can also
be stored inside a folder.

� JPEG
JPEG stands for Joint Photographic Experts Group, and originally
was the name of the group that recommended standardization of
picture compression. JPEG is a file format for compressing and
storing standardized color pictures. The compression rate can be
selected, but the higher the compression rate, the poorer the
picture quality at decompression (picture recovery).

� Motion JPEG
Motion JPEG is a file format AVI (Audio Video Interleave) format
for handling both pictures and audio with one file. The pictures in
the file are recorded in JPEG format.
With a PC, the picture and audio can be reproduced by using the
following software:
Windows: MediaPlayer    ✽ DirectX8.0 or later
Macintosh: QuickTime Player    ✽ QuickTime 3.0 or later

� PC card
A large 54.0 mm width × 85.6 mm long calling card with
a 68-pin socket. Three types are available with lengths
of 3.3 mm (Type I), 5.0 mm (Type II), and 10.5 mm
(Type III). These cards are used as portable PC
memory card and modem, network card, and external
memory device, and similar applications.

� Printpix system
A printing system that uses heat sensitive paper that generates
colors when heated.

� Thermal head
Printing head.

� USB
Stands for Universal Serial Bus, a general-purpose serial
interface standard for low and medium speed devices.

Maintenance

Printer maintenance
� Gently wipe the cabinet and operation panel with a soft cloth. When soiling is severe, wipe with a cloth

dampened with a neutral solvent diluted with water and then wipe with a dry cloth.

� Unplug the power cord plug from the AC outlet before servicing the printer.

The thermal head, lamps, and mechanisms inside the printer have a service life. It is recommended that

they be inspected and replaced about every 3000 sheets.

Symptom Cause Remedy

Edit (ZOOM, MOVE, and EFFECT) is set
for the selected frame.

Press the [EDIT] button and cancel edit
settings by EDIT/PRINT QUALITY.

Printing other than index print cannot be
performed because the file is an AVI file
(moving picture f i le). The icon that
identifies the frame is printed even in the
index print mode.

—
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INSTALLATION WORKFLOW

Using with a PC5

INTRODUCTION TO ACCESSORY SOFTWARE
When the software on CD-ROM is installed, various things can be enjoyed.

Mass Storage Driver
The printer can be used as a USB Mass Storage (removable disk drive, card reader) device.

Exif Launcher
Launches the FinePixViewer when the printer is connected as a card reader.

FinePixViewer
Allows you to display thumbnail lists of the images stored on your PC or in the printer, print the
images individually or as an index, display the images at full size and perform some basic image
processing.

Acrobat® ReaderTM

Software for reading PDF format documents using a PC. Required to read the FinePixViewer and
other manuals.

QuickTimeTM

Software needed for playing back movies, etc.

Printer driver
The CX-400 can be connected to a PC and used as a printer. 

Preparations completed

Macintosh

FinePixViewer installation

USB Mass Storage Driver and Exif Launcher are also installed simultaneously

USB printer driver installation

Check the hardware and software requirements

Acrobat Reader installation

Enable File Exchange

e e Page 80e e Page 57

e e Page 81

e e Page 82

e e Page 83

e e Page 87

e e Page 59

e e Page 60

e e Page 66

� Installation time: Approximately 20 minutes
This time is a criterion only. This time varies depending on the PC and OS used. Read the procedure thoroughly and use
correctly.

� When you have installed all the software...
Once you have finished installing all the software components, remove the CD-ROM. You will need this CD-ROM if you
ever have to re-install any of the software, so keep it in a safe place away from dampness and out of direct sunlight.

Before installation, see “INTRODUCTION TO ACCESSORY SOFTWARE” and “GLOSSARY OF TERMS”
on P. 53 to P. 56.

Windows

� FinePix Internet Service
When a user is registered, various services are received.

e e
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Using with a PC5

� Drive
A peripheral device used by a PC to store and access files.
A disk drive into which removable media can be loaded is referred to as a removable disk drive.
Typical examples include CD-ROM drives and floppy disk drives. A printer is also handled as a disk drive.

� Password
A secret code designed to prevent improper use of your user ID. Type your password when you log in to the
server.
The first time you log in during FinePix Internet Service user registration, type in your choice of password
using letters or numbers. Ensure that you are not observed as you type in your password.

� Server
A computer used on a computer network, such as the Internet, that provides services and data to connected
network users.

� Driver
Software used by a PC to operate a peripheral device.

� File
Data stored on a SmartMedia or on the hard disk of a PC. Files are the units used by PCs and printers to
manage data. For instance, one picture is handled as one file, as is one music track.

� Folder
A location in which related files are stored. Other folders can also be stored inside a folder.

� Install
The process of setting up software on a PC.

Specifications for the 
images to be printed 
(trimming data, etc.)SmartMedia

Images

Drive icons for Windows Device icons for Macintosh

GLOSSARY OF TERMS
This section explains the minimum basic operations you must be familiar with in order to use your PC
(personal computer), along with an introduction to some other operations that will help you to use
your PC more efficiently. For more detailed information on using your PC, refer to the user manuals
supplied with the PC.

� Administrator
The account owned by the computer's administrator. Setting your user privileges to “Administrator” allows
you to use all the functions available in Windows XP.

� Application software
Software used for a specific purpose, such as word processing, spreadsheets or image editing.

� Browser
Software used for viewing web pages on the Internet. Examples include Internet Explorer and Netscape
Navigator.

� Click, Double-click
Click: Pressing the left mouse button (Windows) or the mouse button (Macintosh) once and then releasing it.

� Used to select files, folders, windows, buttons, etc.

Double-click: Clicking the left mouse button (Windows) or the mouse button (Macintosh) twice.
� Used to open files, folders, etc.

� DPOF
A format used for recording information
on SmartMedia that specifies which
images are to be printed.

� Menu
A list of functions displayed at the edge of the screen. Typical examples include the “File” and “Edit” menus.
When a menu name is clicked, a list of the available functions is displayed and a function can then be
performed by moving the mouse to the desired function name.

Left

Double-
click Click

Windows Macintosh

� Drag & drop
An operation used to move, copy or store files and folders.

Drag
1. Position the mouse pointer over the file or folder icon

you want to drag.
2. With the mouse button held down, move the mouse

to another location.

Drop
When you reach the desired location, release the
mouse button.

<Windows> <Macintosh>
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Using with a PC5

PRE-INSTALLATION CHECKLIST

Hardware and software requirements (Windows)
To run this software, you must have the hardware and software described below. Check your system
before you begin the installation.

IBM PC/AT or compatible ✽1

Windows 98 (including the Second Edition)
Windows Millennium Edition (Windows Me)
Windows XP Home Edition ✽3

Windows XP Professional ✽3

Pentium 300 MHz or better

64 MB minimum (for Windows 98/98 Second Edition/Me)
128 MB (for Windows XP)

Amount required for installation . . . 140 MB minimum
Amount required for operation . . . . 300 MB minimum

800 × 600 pixels or better, 16-bit color or better

Modem or ISDN connection, transmission speed
56 kbps minimum (Recommended)

Use a driver (Mass Storage driver, printer driver) compatible with the CD-ROM of this
product. If an old driver is already installed, remove it before installing the driver
supplied with the CD-ROM of this product.

• Connect the PC and printer directly using a USB cable. The software may not operate correctly if you use an
extension cable or connect the printer via a USB hub.

• If the PC has two or more USB ports, the printer can be connected to any port.
• Push the USB connector fully into the socket to ensure that it is securely connected. The software may not operate

correctly if the connection is faulty.
• When an expansion USB interface board was used, operation is not guaranteed.
• Windows 95/2000 cannot be used.
• Operation is not guaranteed on home-built computers or on computers running updated operating system

software.
• Only one CX-400 can be connected to one PC.
• Two or more FUJIFILM printers cannot be connected simultaneously.

Disconnect the USB cable of the printer you do not want to use. (FUJIFILM printers: NX-700/NX-500/NX-800M)

Note

Compatible PCs

Operating System

CPU

RAM

Hard disk space

Display

Internet connection ✽2

✽1  Models with a USB interface as a standard feature and one of the OS shown at the above

operating system preinstalled.
✽2  Required to use FinePix Internet Service. The software can still be installed even if you do not

have an Internet connection.
✽3  When installing and uninstalling the printer driver on Windows XP Professional and XP Home

Edition, use a system administrator account (e.g. “Administrator”) to log in.

Administrator:

This refers to the administrator of the PC used or a user having the administration privilege. For

more information, refer to the Windows user's manual.

� SSL (Secure Sockets Layer)
A communications format with enhanced security functions. Using SSL allows you to exchange data over
the Internet with greater safety.

� Thumbnail
A reduced picture created when pictures are displayed as a list. In FinePixViewer, double-clicking on a
thumbnail picture displays the original picture.

� Uninstall
The process of removing software from a PC and restoring the PC's settings to their original status before
the software was installed.

� User ID
The name by which users are identified. Type your user ID when you log in to the server.
The first time you log in during FinePix Internet Service user registration, type in your choice of user ID
using letters or numbers.

Important Information and Helpful Hints for Internet Users
� Charges
The charges for using the Internet include the following:

Call charges The fees paid for using the phone line; paid to your telephone company.

Connection charges The fees paid for server connection and data storage (E-mail and web pages);
paid to your Internet service provider (ISP).

✽ If the charges vary depending on the call or connection time, you should use your PC's automatic disconnect function
to avoid wasted connection time.

✽ The FUJIFLM FinePix Internet Service includes both free and fee-based services.
✽ If you use online shopping or other services, you will be invoiced for the product or service in addition to the call and

connection charges.

� Viruses
A virus infecting your PC can result in the loss of important data or the sending of unwanted E-mail
messages to the people stored in your address book. Do not open downloaded files or files received as 
E-mail attachments unless you are certain of their content.
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LOAD THE CD-ROM INTO YOUR PC

Installation on a Windows PC6

1 The Setup screen appears. Click the [Installation of FinePixViewer] button.
✽ For more information on what is installed, click the

[Explanation] button.

2 The software version is checked. If the window
shown at the right appears, click the [OK] button
to uninstall the software.

3 The Mass Storage Driver (card reader connection) is installed.

4 Install FinePixViewer.

q FinePixViewer and Exif Launcher installation begins
and notes and warnings are displayed. When these
have been checked, click the [Next>] button.

w Check the installation destination folder and then
click the [Next>] button.

e The screen shown at the right may appear. To
continue with the settings, click the [Yes] button.

Click

Click

Click

Click

Click

Click

� Launching the Installer Manually

Do not connect the printer to your PC until the
software installation is completed.

1 Turn the PC power on and start up Windows.

✽ If you have already turned the PC on, restart it at this point.

2 Quit all other active applications until no applications are shown in the taskbar.

3 Load the enclosed CD-ROM into the CD-ROM drive. The installer starts up
automatically.

• When using Windows XP, use a system administrator account (e.g. “Administrator”) to log in.

Note

• If a “---.dll file not found.” message appears during installation, there is another application running in the
background. Forcibly shut down the application. Refer to your Windows manuals for information on how to forcibly
shut down an application.

Note

<Taskbar>

Applications to be shut down
(The icons shown vary depending on the applications that are running.)

q Click the right mouse button on the application icon in the taskbar.
w Click “Close” in the menu that appears to quit the application.
✽ For more information, refer to the instructions provided with your PC and applications.

q Double-click the “My Computer” icon.
✽ When using Windows XP, click “My Computer” in the “Start” menu.

w Right-click the “Printpix” CD-ROM icon in the “My Computer” window and select
“Open”.

e Double-click “SETUP” or “SETUP.exe” in the CD-ROM window.

✽ The way file names are displayed differs as described below depending on the PC's settings.
• File extensions (3-letter suffixes indicating the file type) may be shown or hidden. (e.g.

Setup.exe or Setup)
• Text may be shown normally or all in uppercase (e.g. Setup or SETUP)
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1 Set the [USB MODE] switch to [PRINTER] and turn the power off.

2 Connect the printer and PC using a USB cable.

3 Turn the printer power on.

4 Check PC operation. This procedure varies depending on the PC OS.

✽ This step is not required for subsequent connections

The Windows CD-ROM may also be required in some cases. Have the CD-ROM ready
beforehand. If no Windows CD-ROM was supplied with your PC, consult the Owner's
Manual for the PC or contact the PC manufacturer.

4 Enter “Printer name”.
Check that “Printer name” is “FUJIFILM CX-400”
and then click the [OK] button to start
installation.

5 At the end of installation, the message shown at the right
appears. Click the [OK] button.

CONNECTING THE PRINTER
Actually connect the printer to the PC and check that the USB printer driver was installed correctly.

Windows 98/98 SE/Me

This places the printer into the
available state.

1 The “New Hardware Found” wizard appears. The wizard will close when the settings are
completed. No action is required.

1 Check
2 Click

Click

6 The screen shown at the right is displayed. click the [Restart]
button.

5 Install QuickTime as directed by the on-screen instructions.

✽ If QuickTime version 5.0 or later has already been installed, this installation is not performed.

Click the [Agree] button in the “Software
License Agreement” window.

If the “Connection speed” window appears,
set the correct speed for your environment
and then click the [Next] button.

✽ If the connection speed is unknown,
simply click the [Next] button.

INSTALL THE PRINTER DRIVER

1 Open “My Computer” and right-click the “Printpix” CD-ROM icon and select “Open”.

2 Double-click “SETUP” or “SETUP.exe” in the CD-ROM.

3 The setup window appears. Click the [Installation of Printer Driver] button.

The message shown at the right appears. Click
the [OK] button.

Click Click

Click

• When installation failed, restart the PC, uninstall the software (P. 70) and then
reinstall FinePixViewer.

Note

• When installation failed, restart the PC and then uninstall the software (P. 71)
and reinstall the printer driver.

Note

Click

Click

Click
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Installation on a Windows PC6

CONNECTING THE PRINTER AS A CARD READER
A Mass Storage Driver is installed when “FinePixViewer” is installed. Check that the printer is
connected as a card reader and the USB Mass Storage Driver was installed correctly.

4 Load a photographed memory card into the printer.

1 Set the printer [USB MODE] switch to [CARD READER] and turn the power off.

2 Connect the printer to the PC using a USB cable.

3 Turn the printer power on.

5 From this point onwards the procedure differs depending on your operating system.

✽ This step is not required for subsequent connections.

• Do not format the memory card on a PC as this may make the card unusable for taking pictures.

Note

Windows 98/98 SE/Me

2 FinePixViewer automatically starts up and the pictures on the memory card are
displayed. A new removable disk icon also appears in the “My Computer” window.

• If FinePixViewer does not start up and the removable disk icon does not appear, the software was not installed
correctly. Disconnect the printer, restart your PC and reinstall the software. If this does not resolve the problem,
refer to the Troubleshooting section.

Note

• When using the printer as a card reader, do not touch the [EJECT] button while the [BUSY] lamp is blinking.

Note

The Windows CD-ROM may also be required in some cases. Have the CD-ROM ready
beforehand. If no Windows CD-ROM was supplied with your PC, consult the Owner's
Manual for the PC or contact the PC manufacturer.

✽ This step is not required for subsequent
connections.

1 The “New Hardware Found” wizard appears. The wizard will close when the settings are
completed. No action is required.

1 The “Found New Hardware” help message
appears in the bottom-right corner of the screen.
This message will close when the settings are
completed. No action is required.

✽ This step is not required for subsequent connections.

Windows XP

2 The following window appears. Select
“Automatically Install Software” (normally, this
item is already selected) and click the [Next>]
button. The wizard starts.

3 At the end of installation, the “Completing the
Found New Hardware Wizard” window appears.
Click the [Finish] button.

This places the printer into the available state.

DISCONNECTING THE PRINTER
Use the following procedure to disconnect the printer from the PC.

1 Check that the printer is not operating.

2 Turn the printer power off.

3 Unplug the USB cable from the printer.

2 Click

1 Click

Click

T IP
• The Exif Launcher installed

with the FinePixViewer
automatically launches
FinePixViewer when the
printer is connected to the PC.
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DISCONNECTING THE CARD READER
Use the following procedure to disconnect the printer from the PC.

1 Exit any applications that are using the printer (FinePixViewer, etc.).

2 Check that media is not being accessed. ([Busy] lamp is off.)

3 Prepare to turn the printer off. This step differs depending on the OS of the PC used.

� Windows 98/98 SE
No PC operations are required.

� Windows Me

• Failure to carry out this step could cause the PC to malfunction.

Note

w Click the “Unplug or Eject Hardware” icon in the taskbar and click “Stop USB Disk Drive”.
When the “Safe To Remove Hardware” dialog box appears, click the [OK] button.

q In the “My Computer” window, right-click the
“Removable disk” icon and then click “Eject”.

q Click the “Unplug or Eject Hardware” icon in the taskbar, click “Safely remove FujiFilm FinePix
Digital Camera” and then click the [Close] button of the “Safe To Remove Hardware” help
message.

Right-click

2 Click

2 Click

1 Click

1 Click

� Windows XP

Windows XP

1 The “Found New Hardware” help message
appears in the bottom right-hand corner of the
screen. This message will close when the
settings are completed. No action is required.

✽This step is not required for subsequent connections.

3 A new removable disk icon appears in “My Computer” window.

2 Specify the settings shown below in the “AutoPlay” window.

� When FinePixViewer is included in the list of actions to perform
Select “Viewing images using FinePixViewer” and then select “Always do the selected
action” checkbox. (This checkbox may not be shown in some cases.) Click the [OK]
button to launch FinePixViewer.

� When FinePixViewer is not included in the list of actions to be performed
Select “Take no action” and then select the “Always do the selected action” checkbox.
(This checkbox may not be shown in some cases.) Click the [OK] button and launch
FinePixViewer manually.

T IP
• From the next t ime you

connect the printer as a card
reader, the removable disk
drive icon and name change
to the “FinePix” icon and
name.

1 Click

2 Click
3 Click

1 Click

2 Click

3 Click

1 Click
2 Click

1 Click

2 Click

• Printer drive indicates “FujiFilm FinePix Digital Camera”.

Note
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PRINTING FROM FinePixViewer

7

2 Set the [USB MODE] switch to the [PRINTER] position and connect the printer to the PC
(P. 61).

1 Load the printing paper into the printer.

Double-click the thumbnail of the picture you
want to print.
Click the “File” menu and then click “Print”.

The “Print” dialog box appears.

4

5 Check that “Name” is “FUJIFILM CX-400” and then click the [Properties] button.

The “FUJIFILM CX-400 Properties” dialog box appears.

q Name: Check the printer name.

w Set printing information.

e Number of copies: Set the number of prints.

r Center Image: Check when you want to print the picture at the center of the printing paper.

t Date imprinting: Check when you want to print the date.

y Adjust to paper size: Check when you want to magnify the print to match the photo paper.

• For applications other than FinePixViewer, the contents that are displayed are different.
• After loading the printing paper into the printer, click the [Properties] button.

Note

1 Click

1 Check

2 Click

Start up FinePixViewer.3

2 Click

4 Turn the printer power off.

Unplug the USB cable from the printer.5

1 Open “My Computer” and right-click the “Printpix” CD-ROM icon and select “Open”.

Double-click “SETUP” or “SETUP.exe” in the CD-ROM.2

3 In the installer window, click the [Installation of Acrobat Reader] button.

4 Proceed with the installation as directed by the on-screen instructions.

This completes installation of all the software
components.

• Always close all the files in the printer (removable disk drive) and confirm that the memory card is not being
accessed ([BUSY] lamp is off).

• In Windows XP and Windows Me, the PC may malfunction if you disconnect the USB cable without first using the
“Remove hardware” procedure.

• When the “Copying” message disappears from the PC screen, wait a few moments before disconnecting the
printer and USB cable or removing memory card. If a large amount of data is being copied, printer access
continues for a short time after the message displayed on the PC has gone off.

Note

Acrobat Reader INSTALLATION
The Adobe Systems ' Acrobat Reader software must be installed to read the FinePixViewer User's Guide (PDF).
If the latest version is already installed, this step is not required.

Click

• When FinePixViewer is started for the first time, the FinePix Internet Service window appears.

Note

4 Set

5 Set

6 Set

3 Set

Click
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7 Adjust the picture quality.

q Click the [Adjustment] tab.

w Automatic print quality adjustment: To adjust picture quality automatically, click “Enable”.

e Manual adjustment:
Picture print quality is adjusted manually. Move the bar and set each item. The picture at the top
right-hand corner of the screen changes with the set value.

Each manual adjustment item can be set even when “Automatic print quality adjustment” is set to
“Enable”.

8 Execute printing.
Click the [OK] button. Printing begins.

• Check “Margins Setting”.
Once with border is selected and the [OK] button in the “Margins Setting” dialog box is clicked, margins are set and
stored. In the case of printing without border, be sure to set margins to 0. If margins are set to larger than 0, border
will be printed even if without border is selected.

Note

1 Click

2 Set

3 Set

Click

6 Set the printing information (Paper Size, Layout, Multiple Print, Border, Quantity).

q Click the [Paper] tab.

w Paper Size: Select the size of the paper.

e Layout: Select the printing direction (Portrait, Landscape).

r Border: Select if a white border is to be printed on the printed photograph.

t Multiple Print:
Print multiple copies of the same picture on one sheet of paper. When multiple print is performed,
the number of frames is selected.

y Quantity: Set the number of copies to be printed.

• “Multiple Print” cannot be selected for without border. Select with border and then select “Multiple Print”.
• The number of frames that can be selected varies depending on the selected paper size.

3” × 4” size: 2UP, 4UP
4” × 6” size: 2UP, 4UP, 9UP, 16UP, 25UP
CD jacket size, digital camera size 3:4: Multiple print cannot be performed.

Note

• Photo type: 3” × 4” size (74 mm × 100 mm/2.9 in. × 3.9 in.), CD Jacket size (100 mm × 120 mm/3.9 in. × 4.7 in.), 
digital camera size 3:4 (100 mm × 133 mm/3.9 in. × 5.2 in.), 4” × 6” size (100 mm × 148 mm/3.9 in. × 5.8 in.),
4” × 7” size (100 mm × 178 mm/3.9 in. × 7.0 in.)

✽ Digital camera size 3:4 is printed at an aspect ratio of 3:4.

Note

1 Click

2 Select

5 Select

4 Set

3 Set

6 Set
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UNINSTALLING THE PRINTER DRIVER
Only perform this operation when you no longer require the installed software. Turn the printer power off.

1 Load the Printpix CD-ROM.
When the installation setup window appears,
click the [Cancel installation] button. Double-click
the “My Computer” icon, right-click the “CD-
ROM” icon and select “Open”.

2 Double-click “Unin_cx.exe” in the CD-ROM
“CX400” folder.
The message shown at the right appears. Click
the [OK] button. Uninstallation begins.

3 When uninstallation is completed, the dialog box shown below appears.

<When restarting is required>

Click the [Yes] button. Click the [OK] button.

<When restarting is not required>

Click

Click Click

UNINSTALLING FinePixViewer AND USB
MASS STORAGE DRIVER
Only perform this operation when you no longer require the installed software. Turn the printer power off.

1 Quit all the currently running applications. Take particular care to shut down Exif
Launcher if it is running (→P. 78  � I want to quit Exif Launcher).

2

3 Open the “My Computer” window and double-click “Add/Remove
Programs” in the Control Panel.

4 The “Add/Remove Programs Properties” window appears. Select the software to be
uninstalled (FinePixViewer or the driver) and then click the [Add/Remove] button.

<To remove FinePixViewer>

5 When the confirmation message appears, click
the [OK] button. Check your selection carefully
since the process cannot be cancelled once you
click the [OK] button.

FinePixViewer Ver.3.0

FUJIFILM USB Driver

• Confirm that the printer power is off.

Note

6 Automatic uninstallation begins.
When uninstallation ends, click the [OK] button.

<To remove the USB Mass Storage Driver>

Double-click

2 Click

1 Select

Click

Click

Close all the files.
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Solution

INSTALLATION PROBLEMS

� The CD-ROM labeled “Windows” was requested during driver installation.

q Replace the Printpix CD-ROM with the Windows CD-ROM.
w Click the [Browse] button in the “Copy files” dialog box.
e In the dialog box that then appears, select the CD-ROM icon in the drive display area,

refer to the information in the table below and specify the appropriate folder and then
click the [OK] button.

r In the “Copy files” dialog box, click the [OK] button to install the driver. Then click the
[Finish] button.

Name of folder ✽ When using CD-ROM Drive DOS Type

Windows 98

Windows Me

Windows XP

D:\win98

D:\win9x

D:\i386

• If no Windows CD-ROM was supplied with the PC, contact the PC manufacturer.

Note

Check Solution

� The printer is connected to the PC but is not recognized.

Turn the printer power on.

Check if one end of the USB cable is
connected to the printer and the other end
is connected to the PC.

Is the printer power on?

Are the printer and PC connected by a USB
cable?

Use the printer with Windows 98/98 SE
/Me/XP.

Is a supported OS used?

Log in by Administrator group. For more
information on Administrator group, refer to
the PC manual.

In the case of Windows XP, does the user
log in  as a member of Administrator group?

If they are displayed, driver was not
installed correctly.
Uninstall the corresponding driver and then
reinstall the driver correctly.

Is “USB Printer” (for printer) or “USB Mass
Storage” (for card reader) displayed at
“Other devices” in Device Manager?

TROUBLESHOOTING TABLE
If the software does not operate correctly, check that you are using the correct hardware and
software (→ P. 57).
If the problem persists even though you are using the correct hardware and software, refer to the
table below and then see the reference page listed for your problem.

Type Problem

Installation problems 73

73

74

76

76

76

76

75

75

Printer problems Pictures cannot be printed from FinePixViewer.

I want to print from an application other than
FinePixViewer.

Application problems FinePixViewer automatic startup is slow.

I want to stop FinePixViewer from launching
automatically.

I want to quit Exif Launcher.

Internet problems I cannot log in to the “FinePix Internet Service”.

I cannot sign on as a “FinePix Internet Service” user.

The Internet menu cannot be updated properly (The
buttons do not line up correctly).

Memory card
problems

The printer is connected to the PC but the
“Removable disk” icon does not appear.

FinePixViewer does not recognize the memory card.

When the “Removable disk” icon is double-clicked, a
“Cannot access drive. The device is not ready.”
warning appears.

When the USB cable is disconnected, a “Device
eject alarm” appears.

77

77

78

78

78

79

79

79

When the USB cable is disconnected or when the
“Removable disk” icon is double-clicked, a message
appears and the window does not open.

When the memory card is accessed, the PC hangs.

The CD-ROM labeled “Windows” was requested
during driver installation.

The printer is connected to the PC but is not
recognized.

When the printer was connected to the PC, the “Add
New Hardware Wizard” appeared.
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PRINTER PROBLEMS

Check Solution

� Pictures cannot be printed from FinePixViewer.

Install the printer driver (→P. 60).

Unplug the USB cable from the printer by
the correct disconnection method and
switch the [USB MODE] switch to the
[PRINTER] position and then reconnect the
USB cable to the printer (→P. 61, 62).

Is the printer driver installed?

Is the [USB MODE] switch set to the
[PRINTER] position?

Select the printer name “FUJIFILM CX-400”
(→P. 67).

Is the printer that is to do the printing
selected?
Is the printer name “FUJIFILM CX-400”?

Solution

� I want to print from an application other than FinePixViewer.

The printer driver can print from various applications.
Select “File” → ”Print” from the menu. The dialog box that appears varies depending on the
application. The items to be set and the printed result are also different. For more
information, refer to the application manual.

Check Solution

• If “Universal Serial Bus controllers” is not
displayed, the USB functions is disabled.
Refer to the User’s Manuals supplied with
your PC for details of how to enable the
USB functions.
USB functions are disabled when the item
is marked with a yellow exclamation mark
“!” or red cross “x”. Refer to the User’s
Manuals supplied with your PC for details
of how to enable the USB functions.

Double-click “System” in “Control Panel”,
select device manager, and check if
“Universal Serial Bus Controller” (for card
reader) and “FUJIFILM USB Printer Device”
(for printer) are displayed.

✽ With Windows XP, when the “System
properties” dialog box appears, click
“Hardware” and then click the [Device
Manager] button.

• When “FUJIFILM USB Printer Device” is
not displayed, the USB driver (printer) was
not installed correctly. Uninstall the driver
and then reinstall the driver correctly.

Check

� When the printer was connected to the PC, the “Add New Hardware
Wizard” appeared.

Install the FinePixViewer and printer drivers
(→P. 59, 60).

Were the FinePixViewer and printer drivers
installed?

Solution
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Check Solution

� When the USB cable is disconnected or when the “Removable disk” icon
is double-clicked, a message appears and the window does not open.

Some USB removable drives do not operate
correctly if other USB removable drives are
being used at the same time. Disconnect all
the connected USB removable drives and
then connect the printer.
However, with some USB storage devices,
computer operation may become unstable
when the Exit Launcher is resident. See “I
want to stop FinePixViewer from launching
automatically” (→ P. 78) and try removing
the Exif Launcher.

Is another USB removable drive connected?

Check Solution

� When the memory card is accessed, the PC hangs.

Install the driver (→P. 59).

The driver is not installed correctly.
Uninstall the corresponding driver and
reinstall it correctly.

Was the driver installed?

Is [USB Printer](for printer) and [USB Mass
Storage] (for card reader) displayed at
“Other devices” in “Device Manager”?

• If “Universal Serial Bus controllers” is not
displayed, the USB functions is disabled.
Refer to the User’s Manuals supplied with
your PC for details of how to enable the
USB functions.
USB functions are disabled when the item
is marked with a yellow exclamation mark
“!” or red cross “x”. Refer to the User’s
Manuals supplied with your PC for details
of how to enable the USB functions.

• When “FUJIFILM USB Printer Device” is
not displayed, the USB driver (printer) was
not installed correctly. Uninstall the driver
and then reinstall it correctly.

Double-click “System” in “Control Panel”
and select “Device Manager”, and then
check if “Universal Serial Bus Controller”
(for card reader) and “FUJIFILM USB
Printer Device” (for printer) are displayed.

MEMORY CARD PROBLEMS

Check Solution

� The printer is connected to the PC but the “Removable disk” icon does not
appear.

Unplug the USB cable from the printer by
the correct disconnection method and
switch the [USB MODE] switch to [CARD
READER] and then reconnect the USB
cable to the printer (→P. 63 to 66).

Insert a memory card into the printer.

Is the [USB MODE] switch in the [CARD
READER] position?

Is a memory card inserted into the printer?

Install FinePixViewer.Was FinePixViewer installed correctly?

Check Solution

� When the “Removable disk” icon is double-clicked, a “Cannot access
drive. The device is not ready.” warning appears.

Insert a memory card into the printer.Is a memory card inserted into the printer?

Check Solution

� When the USB cable is disconnected, a “Device eject alarm” appears.

Before disconnecting the USB cable, click
the “Unplug or Eject Hardware” icon on the
task bar and disconnect the printer (→P. 65).
When the USB cable was disconnected by
the incorrect method, Windows may be
faulty. Reboot Windows.

Was the USB cable disconnected by the
correct disconnection method (Windows
Me/XP).

Check Solution

� FinePixViewer does not recognize the memory card.

Turn the printer power on.Is the printer power turned on?

Check if one end of the USB cable is
connected to the printer and the other end
is connected to the PC.

Are the printer and PC connected by a USB
cable?

Unplug the USB cable from the printer by
the correct disconnection method and set
the [USB MODE] switch to the [CARD
READER] position and then reconnect the
USB cable to the printer (→P. 63 to 66).

Is the [USB MODE] switch in the [CARD
READER] position?

Select “View” → “Refresh” from the
FinePixViewer menu.

Updated to newest data?
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INTERNET PROBLEMS

Check Solution

� I cannot log in to the “FinePix Internet Service”.

Check the PC environment.

Log in after maintenance is completed.

Is Internet connection possible?

Is “FinePix Internet Service” undergoing
maintenance?

Click the FinePixViewer the [Register Now]
button and sign on as a “FinePix Internet
Service” user.

Is user registration process completed?

Check Solution

� I cannot sign on as a “FinePix Internet Service” user.

You cannot sign on twice with the same
user ID or E-mail address.

Are you already signed on by same E-mail
address?

Solution

� The Internet menu cannot be updated properly (The buttons do not line up
correctly).

The menu data is corrupted. Use the procedure below to update the menu:
q Quit FinePixViewer.
w From the “Start” menu, select “FinePixViewer” in “Programs”. Then right-click on the

“FinePixViewer” icon in the “FinePixViewer” folder and select “Properties”.
e Click the [Find Target] button to display the folder in which FinePixViewer was installed.
r Delete the “FinePixInternetFiles” folder in the FinePixViewer installation folder.
t Launch FinePixViewer and click “Menu Update” in the “View” menu.

APPLICATION PROBLEMS

Check Solution

� FinePixViewer automatic startup is slow.

Click the [Start] button and select
“Programs” → “Startup” from the Start
menu. Right-click on any shortcuts for
infrequently used applications from the
“Startup” window. Click “Delete” from the
pop-up menu and then restart your PC.

Are there too many resident applications?

Check

� I want to quit Exif Launcher.

Right-click the Exif Launcher icon in the
taskbar and select “Exit” from the pop-up
menu.

Is there an Exif Launcher icon on the
taskbar?
(When there is no Exif Launcher icon on the
taskbar, Exif Launcher does not start.)

Solution

� I want to stop FinePixViewer from launching automatically.

Either of the following two methods can be used to prevent FinePixViewer from launching
automatically:
• Change the Exif Launcher settings
q Right-click the Exif Launcher icon in the taskbar and select [Settings] from the pop-up

menu.
w Clear the “Start automatically when connected” checkbox.
✽ To restore the original setting, use the same procedure and place a tick in the

automatic launch checkbox.
• Remove Exif Launcher
q Right-click the Exif Launcher icon in the taskbar and select “Exit” from the pop-up

menu.
w Click the [Start] button and select “Programs” → “Startup”. Right-click “Exif Launcher”

and select “Delete” from the pop-up menu.
✽ To restore the original setting, create a shortcut to Exif Launcher in the “Startup”

folder.

Solution
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CHECKING THE OS SETTINGS

1 Turn the Macintosh power on and startup the Mac OS.

2 Select the Extensions Manager in the Control Panels and check that the File Exchange
check box is ticked. If not, click in the box so that an appears and then restart the
Macintosh.

• Do not connect the printer until software installation is completed.

Note

Enable File Exchange
Check whether File Exchange is active.
To use a memory card supported by the printer, “File Exchange” utility supplied with the Mac OS
must be running.

PRE-INSTALLATION CHECKLIST

Hardware and software requirements (Macintosh)
To run this software, you must have the hardware and software described below. Check your system
before you begin the installation.

• Connect the printer directly to the Macintosh using a USB cable. The software may not operate correctly if an
extension cable or USB hub is used.

• Push the USB connector fully into the socket to ensure that it is securely connected. The software may not operate
correctly if the connection is faulty.

• When an additional USB interface board is used, operation is not guaranteed.
• Only one CX-400 can be connected to one PC.
• Two or more FUJIFILM printers cannot be connected simultaneously.

Disconnect the USB cable of the printer you do not want to use. (FUJIFILM printers: NX-700/NX-500/NX-800M)

Note

Power Macintosh G3 ✽1, PowerBook G3 ✽1

Power Macintosh G4, iMac, iBook,
Power Macintosh Cube, PowerBook G4

Mac OS 8.6 to 9.2 

64 MB minimum ✽2

Amount required for installation . . . .70 MB minimum
Amount required for operation . . . .300 MB minimum

800 × 600 pixels or better, approx. 32,000 colors

Transmission speed 56 kbps minimum (recommended) 
modem connection or ISDN connection

Compatible models

Operating System

RAM

Hard disk space

Display

Internet connection ✽3

✽1  Models with a USB port as a standard feature.
✽2  Turn virtual memory on if necessary.
✽3  Required to use FinePix Internet Service. The software can still be installed even if you do not

have an Internet connection.

Use the drivers (Mass Storage Driver, printer driver) on the CD-ROM supplied with this
product. When an old driver has already been installed, uninstall it and then install the
driver on the CD-ROM supplied with this product.
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5 Install QuickTime as directed by the on-screen instructions and then restart your Macintosh.
✽ If you have already installed QuickTime version 5.0 or later, this installation is not performed. 

Click the [Agree] button in the “License”
window.

If the “Connection Speed” window appears
after your restart your Macintosh, set the
correct speed for your environment of
connection and then click the [Next] button.
✽ If you do not know your connection speed,

simply click the [Next] button.

Click Click

6 The window at the right appears. Click the
[Restart] button.

FROM PRINTER DRIVER INSTALLATION TO RESTART

1 Double-click the “Installer” icon to launch the installer.

2 Click the [Installation of Printer Driver] button at
the setup window.

The message shown at the right appears. Click
the [OK] button.

Printer driver installation begins.
Click

FROM FinePixViewer INSTALLATION TO RESTART

1 When the enclosed CD-ROM is loaded into the
CD-ROM drive, the “Printpix” volume is
automatically opened.

2 Double-click the “Installer” icon to launch the installer.

3 The installer setup window appears. Click the [Installation of FinePixViewer] button.
✽ For more information on what is installed, click the

[Explanation] button.

• If the “Printpix” volume does not automatically open, double-
click the CD-ROM icon.

Note

4 Select the installation destination for FinePixViewer.
q Click the [Open] button to open the installation

destination folder.

w Click the [Save] button.

Double-click

Click

Click

1 Select

2 Click

Click

• When installation failed, restart the Macintosh and uninstall
(P. 91) and then reinstall FinePixViewer.

Note Click

Click

Click
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CONNECTING THE PRINTER AS A CARD READER
Connect the printer as a card reader and check that the USB Mass Storage Driver was installed
correctly. The Mass Storage Driver is installed at “FinePixViewer” installation.

4 Load a photographed memory card into the printer.

1 Set the printer [USB MODE] switch to [CARD READER] and turn the power off.

2 Connect the printer to the Macintosh using a USB cable.

3 Turn the printer power on.

5

• Do not format the memory card on the Macintosh as this may take the card unusable for taking pictures.

Note

FinePixViewer is automatically started and the pictures on the memory card are
displayed. A new “Removable disk” icon also appears on the desktop.

• If FinePixViewer does not start up and the removable disk icon does not appear, the software was not installed
correctly. Disconnect the printer and restart the Macintosh and then reinstall the software. If this does not resolve
the problem, refer to the Troubleshooting section.

Note

• When disconnecting the printer, always turn the power off using the specified procedure.
• When connecting the printer and Macintosh, do not perform the following operations. The memory card or the data

on the memory card may be destroyed.
Do not disconnect the USB cable or touch the printer (power switch, operation buttons, etc.)

Note

1 Set the printer [USB MODE] switch to [PRINTER] and turn the power off.

2 Connect the printer to the Macintosh using a USB cable.

3 Turn the printer power on.

4 The Macintosh automatically recognizes the printer.

The printer can now be used.

3 When installation is completed, the message
shown at the right appears.
Click the [Restart] button.

The Macintosh restarts.

CONNECTING THE PRINTER
Connect the printer to the Macintosh and check if the USB printer driver is installed correctly.

1 Check that the printer is not operating.

2 Turn the printer power off.

3 Unplug the USB cable from the printer.

DISCONNECTING THE PRINTER
To disconnect the printer from the Macintosh, use the following procedure.

Click

• When installation failed, restart the Macintosh and uninstall
(P. 91) and then reinstall the printer driver.

Note

T IP
• The Exif Launcher installed

with the FinePixViewer
automatically launches
FinePixViewer when the
printer is connected to the
Macintosh.

• When using the printer as a card reader, do not touch the [EJECT] button while the [BUSY] lamp is blinking.

Note
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Installation on a Mac OS10

Acrobat Reader INSTALLATION
Adobe Systems' Acrobat Reader software must be installed to read the FinePixViewer User's Guide
(PDF). If you already have the latest version installed, this step is not required.

1 Double-click the “Installer” icon to launch the installer.

3 Install Acrobat Reader as directed by the on-screen instructions.

This completes installation of all the software
components.

2 An installer setup window appears.
Click the [Installation of Acrobat Reader] button.

DISCONNECTING THE CARD READER
To disconnect the printer from the Macintosh, follow the procedure below.

1 Quit all applications (FinePixViewer, etc.) that are using the printer.

2 Check that the printer and Macintosh are not communicating.

3 Drag the removable disk icon to “Trash”.

4 Turn the printer power off.

Unplug the USB cable from the printer.5

• Always close all the files in the printer (removable disk drive) and confirm that the memory card is not being
accessed ([BUSY] lamp is off).

• If the printer or USB cable is disconnected without dragging the removable disk icon to “Trash”, the Macintosh may
malfunction.

• Do not disconnect the printer or USB cable immediately after the Macintosh “Copying” message disappears from
the screen. When a large amount of data was copied, the printer may be accessed for a short after the Macintosh
display disappears.

Note

Click

Click
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3

2 Set

3 Set

1 Select

4 Select 5 Click

6 Click

PRINTING FROM FinePixViewer

Setting the printer
Before printing, set the printer.

Click the Macintosh “Apple” menu and click
“Chooser”.

The “Chooser” window opens.

3 1 Click

2 Click

Click the “CX-400” icon.

When the printer is connected, the “Chooser” window
changes as shown at the right.

Finally, close the “Chooser” window.

This completes printer setting.

4

1 Click
2 Click

• If the “CX-400” icon does not appear at the right-hand side of
the “Chooser” screen even when the “CX-400” icon is
clicked, the Macintosh and printer are not connected. Close
the “Chooser” window and check if the USB cable is
connected correctly. After checking the USB cable, open the
“Chooser” window again.

Note

2 Set the [USB MODE] switch to [PRINTER] and connect the Macintosh (P. 84).

1 Load the printing paper into the printer.

Printing from the Macintosh

• When FinePixViewer is launched for the first time, the Finepix Internet Service introduction window is displayed.

Note

1 Launch FinePixViewer.

Double-click the thumbnail of the picture you
want to print.
Click the “File” menu and click “Page Setup”.

The “Page Setup” window appears.

2 1 Click

2 Click

3 Click

Set the printing information (Paper Size, Layout, Multiple Print, Border, Quantity).

q Paper Size: Select the size of the paper.

w Layout: Select the printing direction (portrait, landscape).

e Border: Select if a white border is to be printed on the printed photograph.

r Multiple Print:
Print multiple copies of the same picture on one sheet of paper. When multiple print is performed,
the number of frames is selected.

t Manual adjustment:
Click to manually adjust the picture quality.
Each manual adjustment item can be set even when automatic print quality adjustment is set to
“Enable”.

At the end of setting, press the [OK] button.

• “Multiple Print” cannot be selected for without border. Select with border and then select “Multiple Print”.
• The number of frames that can be selected varies depending on the selected paper size.

3” × 4” size: 2UP, 4UP
4” × 6” size: 2UP, 4UP, 9UP, 16UP, 25UP
CD jacket size, digital camera size 3:4: Multiple print cannot be performed.

Note

• After loading the paper into the printer, click the “File” menu
and click “Page Setup”.

Note

• Photo type: 3” × 4” size (74 mm × 100 mm/2.9 in. × 3.9 in.), CD Jacket size (100 mm × 120 mm/3.9 in. × 4.7 in.), 
digital camera size 3:4 (100 mm × 133 mm/3.9 in. × 5.2 in.), 4” × 6” size (100 mm × 148 mm/3.9 in. × 5.8 in.),
4” × 7” size (100 mm × 178 mm/3.9 in. × 7.0 in.)

✽ Digital camera size 3:4 is printed at an aspect ratio of 3:4.

Note
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UNINSTALLING THE SOFTWARE
Only perform this operation when you no longer require the installed software or when the software
was installed incorrectly.

Uninstalling Mass Storage Driver

1 Check that the printer power is off.

Open the “Extensions” folder in the System Folder of boot volume, and put the following
four files into the “Trash”.

“USB04CB_StorageDriver”
“USB04CB_StorageShim”
“USB04CB_VcDriver”
“USB04CB_VcShim”

2

Uninstalling Exif Launcher and FinePixViewer

1 After quitting Exif Launcher in the FinePixViewer “Settings” → “Exif Launcher Setting”
menu, move the Exif Launcher file from the “Startup Items” folder in the System folder to
the “Trash”. Then click “Empty Trash” in the “Special” menu (→ P. 96 � I want to stop
FinePixViewer from launching automatically).

After your have exited FinePixViewer, drag the installed “FinePixViewer” folder to the
“Trash” and click “Empty Trash” in the “Special Menu”.

2

Restart the Macintosh.3

Click “Empty Trash” in the “Special” menu.4

90

Printing from the Macintosh11

� Manual adjustment
Move and set the bar of each item. The
picture at the top right-hand side of the screen
varies with the set value.
At the end of setting, click the [OK] button.

Click the “File” menu and click “Print”.

The “Set print” window appears.

4

Set number of prints, printing zone, and other items and execute printing.

q Quantity: Selects the number of prints.

w Center Image: Check when you want to print the picture at the center of the paper.

e Date imprinting: Check when you want to print the date on the picture.

r Adjust to paper size: Check when aligning the printing zoom rate with the paper.

At the end of setting, click the [OK] button.

5

• Check “Margins Setting”.
Once with border is selected and the [OK] button in the “Margins Setting” dialog box is clicked, margins are set and
stored. In the case of printing without border, be sure to set margins to 0. If margins are set to larger than 0, border
will be printed even if without border is selected.

Note

2 Click

1 Set

1 Set

2 Set

3 Set

4 Set

5 Click

1 Click

2 Click
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Uninstalling the software12

TROUBLESHOOTING TABLE
If the software does not operate correctly, check that you are using the correct hardware and
software (→ P. 80).
If the problem persists even though you are using the correct hardware and software, refer to the
table below and then see the reference page listed for your problem.

Type Problem

Installation problems
94

95

95

96

95

94

94

Printer problems Pictures cannot be printed from FinePixViewer.

Application problems

I want to stop FinePixViewer from launching
automatically.

Internet problems I cannot log in to “FinePix Internet Service”.

I cannot sign on as a “FinePix Internet Service” user.

I cannot update the Internet menu properly (The
buttons do not line up correctly).

Memory card
problems

The printer is connected to the Macintosh, but the
“Removable disk” icon is not displayed.

FinePixViewer does not recognize the memory card.

Mac OS “Initialize disk” message was displayed.

A warning message appears when the memory card
was removed or the USB cable was disconnected
from the printer.

96

96

96

97

97

97

The Macintosh hangs when the memory card is
accessed.

When the printer was connected to the Macintosh,
the “Required software was not found” message or
“Required driver cannot be used” message appears.

Uninstalling printer driver
This operation uninstall CX-400 printer driver which was installed through “FROM PRINTER DRIVER
INSTALLATION TO RESTART” procedure (P. 83).

Load the Printpix CD-ROM into the CD-ROM
drive.

1

Double-click “CX-400 Uninstaller” in the CD-
ROM “CX-400” folder. The message shown at
the right appears. When the [OK] button is
clicked, uninstallation is started.

2

At the end of uninstallation, the message shown
at the right appears.
Click the [Restart] button.

The Macintosh restarts.

3

Click

Click

I want to print pictures from an application other than
FinePixViewer.

I want to quit Exif Launcher.
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MEMORY CARD PROBLEMS

� The printer is connected to the Macintosh, but the “Removable disk” icon
is not displayed.

Load a memory card into the printer.Is a memory card loaded into the printer?

Check Solution

� Mac OS “Initialize disk” message was displayed.

Format the memory card using a FinePix
digital camera.

Do you have a FinePix digital camera?

Enable “File Exchange” in Extension
Manager and then restart the Macintosh 
(→P. 81).

Is File Exchange enabled? (When viewing
pictures taken with a FinePix digital
camera.)

Check Solution

� FinePixViewer does not recognize the memory card.

Turn the printer power on.Is the printer turned on?

Check if one end of the USB cable is
connected to the printer and the other end
is connected to the Macintosh.

Are the printer and Macintosh connected by
a USB cable?

Unplug the USB cable from the printer by
the correct disconnection method, switch
the [USB MODE] switch to [CARD
READER], and then reconnect the USB
cable to the printer.

Is the [USB MODE] switch in the [CARD
READER] position?

Select “View” → “Refresh” from the
FinePixViewer menu.

Is the window of FinePixViewer updated to
the newest information?

Check Solution

Turn the printer power on.Is the printer power turned on?

Use the printer with Mac OS 8.6 to 9.2.Is a compatible OS used?

Check if one end of the USB cable is
connected to the printer and the other end
is connected to the Macintosh.

Are the printer and Macintosh connected by
a USB cable?

At the Extension Manager, enable
“USB04CB_StorageShim” and “USB04CB
_StorageDriver” and then restart the
Macintosh.

Is Mass Storage Driver enabled?

Unplug the USB cable from the printer by
the correct disconnection method, switch
the [USB MODE] switch to [CARD
READER] and then reconnect the USB
cable to the printer (→P. 85, 86).

Is the [USB MODE] switch in the [CARD
READER] position?

94
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INSTALLATION PROBLEMS

� When the printer was connected to the Macintosh, the “Required software was
not found” message or “Required driver cannot be used” message appears.

Check Solution

Install the software (→P. 82, 83).Is the software installed?

PRINTER PROBLEMS

Check Solution

� Pictures cannot be printed from FinePixViewer.

Install the printer driver (→P. 83).

Unplug the USB cable from the printer by
the correct disconnection method, switch
the [USB MODE] switch to [PRINTER], and
then reconnect the USB cable to the printer
(→P. 84).

Is the printer driver installed?

Check if one end of the USB cable is
connected to the printer and the other end
is connected to the Macintosh.

Are the printer and Macintosh connected by
a USB cable?

Is the [USB MODE] switch in the
[PRINTER] position?

Select CX-400 as the printer (→P. 88).Is the picture to be printed selected?
Is the CX-400 selected in the Chooser?

Set “CX400”, “CX-400Monitor”, “FTLUSB
_Lib”, and “FTLUSB_Drv_04CB010C” in
Extensions Manager to Enable and restart
the Macintosh.

Is the printer driver enabled?

Solution

� I want to print from an application other than FinePixViewer.

Select “File” → “Print” from the menu. The dialog box that is displayed here varies
depending on the application. The setting items and printed result are also different. For
more information, refer to the application manual.
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Check Solution

� I cannot log in to the “FinePix Internet Service”.

Check the Macintosh environment.

Log in after maintenance is completed.

Can you connect to the Internet?

Is the “FinePix Internet Service” undergoing
maintenance?

Click the FinePixViewer [Register Now]
button and sign on as a “FinePix Internet
Service” user.

Has the user registration process been
completed?

Check Solution

� I cannot sign on as a “FinePix Internet Service” user.

You cannot sign on twice with the same
user ID or E-mail address.

Have you already signed on under the
same E-mail address?

Solution

� I cannot update the Internet menu properly (The buttons do not line up
correctly).

The menu data is corrupted. Use the procedure below to update the menu:
q Quit FinePixViewer.
w Delete the menu data in the following locations:

The “FinePixInternetFiles” folder inside “Preferences” in the
System Folder.

e Launch FinePixViewer and click “Menu Update” in the “View” menu.

Mac OS 8.6–9.2

INTERNET PROBLEMS

Check Solution

� The Macintosh hangs when the memory card is accessed.

Install the software (→P. 82).Is the software installed?

Solution

� A warning message appears when the memory card was removed or the
USB cable was disconnected from the printer.

This operation may destroy the memory
card and data. Drag the drive icon to
“Trash” before disconnecting the USB cable
from the printer.

Was the USB cable unplugged while the
printer was mounted as a disk drive?

APPLICATION PROBLEMS

Solution

� I want to quit Exif Launcher.

Select “Exif Launcher Setting” in the FinePixViewer “Settings” menu and click “Quit Exif
Launcher immediately”.

Solution

� I want to stop FinePixViewer from launching automatically.

Either of the following two methods can be used to prevent FinePixViewer from launching
automatically.
• Change the Exif Launcher settings
q Select “Exif Launcher setting” in the Settings menu in FinePixViewer and click “Do not

run Exif Launcher at restart”.
w Restart your Macintosh.
✽ To restore the original setting, use the same procedure and select the “Run Exif

Launcher at restart” checkbox. Then restart your Macintosh.
• Remove Exif Launcher.
q Select “Exif Launcher Setting” in the Settings menu in FinePixViewer and select the

“Quit Exif Launcher immediately” checkbox.
w Open “System Folder” → “Startup Items” and drag “Exif Launcher” to the Trash.
e Select “Empty Trash...” in the “Special” menu.
✽ To restore the original setting, reinstall the software.

Check
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Specifications

FUJIFILM Digital Photo Printer CX-400
Printpix system
Printpix paper of standard roll type  RK-SD40
100 mm × 7.09 m/0.3 ft. × 23.3 ft. (40 prints, 4” × 6” size)
74 × 100/3 × 4: full size, 2 up, 4 up
100 × 120/4 × 4.7: full size
100 × 133/4 × 5.2: full size
100 × 148/4 × 6: full size, 2 up, 4 up, 9 up, 16 up, 25 up, index 25 up
100 × 178/4 × 7: full size
Note: Only full-size prints can be borderless.
Max. 1220 (V) × 2172 (H) pixels (4” × 7” size without borders)
310 dpi
16.77 million colors (256 gradations of Y, M, C)
Approx. 99 seconds/4” × 6” size (without border)
• Borderless print
• Full print
• Index print (25 up)
• Multiple print (2 up, 4 up, 9 up, 16 up, 25 up)
• All print (Automatically prints all the frames in the memory card)
• Zoom print • Rotation print • Edit/Print quality print
• DPOF print • Exif Print • ID print
• 55 × 100/2 × 4: 2 up (35 × 45)
• 74 × 100/3 × 4: 2 up (45 × 60)
• 100 × 148/4 × 6: full size (126 × 85), 2 up (55 × 75), 4 up (50 × 38)
✽1 The number of ID photo frame is selectable.

The frame size can also be adjustable in 1 mm steps.
SmartMediaTM, PC-ATA card
2, 4, 8, 16, 32, 64, 128 MB (Only use 3.3 V SmartMedia)
DCF, Exif 1.0 to 2.2 ✽2 (JPEG, TIFF-YC/RGB),
BMP (21bit0), DPOF
✽2 Exif 2.2 is a newly revised digital camera file format that contains a variety of shooting 

information for optimal printing.
120 × 160 to 6144 × 6144 Pixels
NTSC video out (RCA pin jack) (U.S.A. and Canada)  ✽ Use a VIDEO cable less than 3.0 m long.
PAL video out (RCA pin jack ) (other countries)
Built in 1.8 inch color LCD
USB (Windows 98/98 SE/Me/XP, MacOS 8.6 to 9.2)  ✽ Use a USB cable less than 3.0 m long.
Automatic roll paper feeding (40 prints, 4” × 6” size) 
AC 120 V, 60 Hz (U.S.A. and Canada: NTSC)
AC 220 V to 240 V, 50/60 Hz (other countries: PAL)

Printing : Approx. 2.5 A max. Standby : Approx. 0.3 A (U.S.A. and Canada)
Printing : Approx. 1.3 A max. Standby : Approx. 0.2 A (other countries)

250 (W) mm × 179.5 (H) mm × 330 (D) mm
9.8 (W) in. × 7.1 (H) in. × 13.0 (D) in.
Approx. 5.0 kg/11.0 lbs
+5 °C to +30 °C (+41 °F to +86 °F), 15 % RH to 80 % RH (No condensation)
+30 °C to +35 °C (+86 °F to +95 °F), 15 % RH to 60 % RH (No condensation)
Approx. 1.8 m
Windows 98/98 SE/Me/XP
Mac OS 8.6 to 9.2
Owner’s Manual, Power cord, Trash box
Paper tray, Paper case, Retaining ring, CD-ROM
Paper holder q, Paper holder w, Cleaning paper, Cleaning paper core

Model
Printing method
Paper (Roll type)
Paper size
Print size (mm/inch)

Image size
Print resolution
Color supported
Print speed 
Print functions

ID print size (Default) ✽1

(mm/inch)

Input source
Compatible SmartMedia
Input image format

Input image size
Video output

Monitor
Digital interface
Paper feeding method
Power supply

Power consumption

Dimensions

Mass (Weight)
Operating conditions

Power cord length
Operating system

Accessory

• Exif Ver 2.2 is a picture standard that substantially expands the functions of the original Exif. However, Exif compatible machines may limit the
functions.

• SmartMedia (64 MB) formatted by the following FUJIFILM digital cameras cannot be used.
FinePix 700, FinePix 500, CLIP-IT-50, DS-250HD (For compatibility of other makes of digital cameras, please contact the camera manufacturer.)

• These specifications are subject to change without notice.

WARNING
To prevent fire or shock hazard, do not expose the unit to rain or moisture.

This symbol is intended to alert the user to the
presence of uninsulated “dangerous voltage”
within the product’s enclosure that may be of
sufficient magnitude to constitute a risk of
electric shock to persons.

This symbol is intended to alert the user to the
presence of important operating and
maintenance (servicing) instructions in the
literature accompanying the appliance.

For customers in the U.S.A.
FCC Statement
This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this
device must accept any interference received, including
interference that may cause undesired operation.

CAUTION
This equipment has been tested and found to comply with
the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause
harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more
of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and
receiver.
Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.
Consult the dealer or an experienced radio/ TV
technician for help.

You are cautioned that any changes or modifications not
expressly approved in this manual could void the user’s
authority to operate the equipment.

For customers in Canada
CAUTION
This Class B digital apparatus complies with Canadian
ICES-003.

Owner’s Record
The model and serial numbers are located on the rear
panel. Record the serial number in the space provided
rear. Refer to these whenever you call upon your
FUJIFILM dealer regarding this product.

Model No. Printpix CX-400

CAUTION: TO REDUCE THE RISK OF 
ELECTRIC SHOCK. DO NOT REMOVE 

COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.

REFER SERVICING TO QUALIFIED 
SERVICE PERSONNEL.

The graphical symbols are located on the rear panel of the case.

�Notes on Copyright
�The use of prints made using images other than

those created or photographed by you without the
permission of the copyright holder is prohibited under
copyright law, except where the prints are for
personal use only.
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EC DECLARATION OF CONFORMITY
We
Name: Fuji Photo Film (Europe) G.m.b.H.
Address: Heesenstrasse 31, 40549 Dusseldorf, Germany

declare that the product
Product Name: FUJIFILM Digital Photo Printer Printpix CX-400
Manufacturer’s Name: Fuji Photo Film Co., Ltd.
Manufacturer’s Address: 26-30, Nishiazabu 2-chome, Minato-ku, Tokyo 106-8620, Japan

is in conformity with the following Standards
Safety: EN60065
EMC: EN55022: 1988 Classe B 

EN55024: 1988
EN61000-3-2, EN61000-3-3:1955 + A1:1988 + A2:1988

following the provisions of the EMC Directive (89/336/EEC, 92/31/EEC and 93/68/EEC) and Low Voltage Directive
(73/23/EEC).

Dusseldorf, Germany June 1, 2002
Place Date Signature/Managing Director
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Print Size
• Full Print, Multiple Print, Index Print 

• ID Print 

100 mm × 148 mm
(3.9 in. × 5.8 in.)

100 mm × 74 mm
(3.9 in. × 2.9 in.)

100 mm × 120 mm
(3.9 in. × 4.7 in.)

100 mm × 133 mm
(3.9 in. × 5.2 in.)

100 mm × 148 mm
(3.9 in. × 5.8 in.)

100 mm × 178 mm
(3.9 in. × 7.0 in.)

4” × 6” Size

3” × 4” Size

CD Jacket Size

4” × 5.2” OR 6”

4” × 7” Size

Full Print Multiple Print Index
25 up

Print Size

Without Border With Border 2

－ 

－ 

－ 

4

－ 

－ 

－ 

9

－ 

－ 

－ 

－ 

16

－ 

－ 

－ 

－ 

25Actual Size

－ 

－ 

－ 

－ 

－ 

－ 

－ 

－ 
✽

✽ : 100 mm × 133 mm (4 in. × 5.2 in.) or 100 mm × 148 mm (4 in. × 6 in.) depending on the vertical/horizontal ratio of the picture.

100 mm × 148 mm

74 mm × 100 mm

55 mm × 100 mm

20 mm − 142 mm

20 mm − 194 mm

20 mm − 194 mm

20 mm − 94 mm

20 mm − 68 mm

20 mm − 49 mm

Frame Size Number of Frames
Paper Size

VerticalHorizontal

1 − 6

1 − 4

1 − 4

1 − 4

1 − 3

1 − 2

VerticalHorizontal



Printed in Japan FGS-204106-FG

Printed on recycled paper.26-30, Nishiazabu 2-chome, Minato-ku, Tokyo 106-8620, Japan


